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Revision history

Version Date Comments

a 22.05.2012 First edition

b 06.07.2012 Changes to .MAP120 release 2.1

c 04.04.2013 Changes to .MAP120 release 2.2

d 15.11.2013 Changes to .MAP120 release 2.3; Support for Windows 8, comparison of device descrip-

tions, separate layout definitions for print and comparison. Print preview changed, check
for update can be called up from "About" window.
Several minor changes (text, screenshots, index).

e 09.12.2014 Changes to .MAP120 release 3.0 (see also read-me file); Communication with message
security and additional access mechanisms (authentication), individual passwords and
keys per device, enhanced storage policy for keys and passwords, enhanced character set
for passwords, new icons in communication toolbar, new folder icon in tree, new repre-
sentation of errors and warnings. Document structure modified.

f 17.03.2015 Changes to .MAP120 release 3.1 (see also read-me file); Toolbars and status bar of device
description window changed, new progress visualisation while reading from device, creat-
ing or opening device descriptions.

g 26.10.2015 Changes to .MAP120 release 3.4 (see also read-me file); Operating System Windows 10
supported, "Uninstall" removed from start menu, "File new" split into two menu items,
block transfer for write, set and action services can be enabled/disabled in the dims appli-
cation layer settings, several minor changes (text, screenshots, index).

h 07.09.2016 Changes to .MAP120 release 3.7 (see also read-me file); New version of communication
settings, TCP and UDP supported in network layer, New search function added to the tree
view toolbar, Update to Microsoft .NET framework 4.6. About box extended with license
information.

k 31.05.2017 Changes to .MAP120 release 3.9 (see also read-me file); New section 2.3 for required
setting when operating .MAP120 on high resolution displays, several shifts of menu items
in the menu bar, changed firmware selection for creation of new device descriptions,
updated parameterisation wizard for new device types, new version of communication
settings, extended access levels, new level authentification using SHA-256, several minor
changes (text, screenshots).

m 18.07.2019 Changes to .MAP120 release 4.4 (see also read-me file); adaptation to changed communi-
cation user interfaces.

n 13.01.2020 Changes to .MAP120 release 4.5 (see also read-me file); adaptation to changed communi-
cation user interfaces. New screenshots with Windows 10 operating system.

Nothing in this document shall be construed as a representation or guarantee in respect of the performance, quality or durability of the specified
product. Landis+Gyr accepts no liability whatsoever in respect of the specified product under or in relation to this document.

Subject to change without notice.
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Introduction

Scope

Purpose

Target group

Conditions

Conventions

Landis+Gyr

Introduction

The present user manual is designed for the Landis+Gyr .MAP120 Parameter
Editor Release 4.5 and higher.

This user manual contains all information required for the use of the Landis+Gyr
.MAP120 Parameter Editor. It not only provides explanations concerning function-
ality and general procedures, but also gives detailed, illustrated instructions on
how to use the software.

The contents of this user manual are intended for technically qualified personnel
of energy supply companies responsible for system planning, parameter setting
and installation of devices.

The Landis+Gyr .MAP120 Parameter Editor runs on PCs with Windows operating
system. To understand this user manual, you need basic knowledge of Windows
and its terms, as well as a general idea of how to operate a PC. Furthermore, you
need to be familiar with the functional principles of the various devices supported
by the Landis+Gyr .MAP120 Parameter Editor, which are described in the corre-
sponding user manuals and functional descriptions.

The following conventions are used in this manual:

1.2.3. Ordinal numbers are used for individual steps in the instructions.

Tools Buttons, menu names and individual menu items appear in bold
text.

[F1] Keys are shown in square brackets.

[Ctri]+[V] Key combinations are shown with a plus sign (e.g. [Ctrl] key kept
pressed while pressing [V] key)

"Options" Names of windows and elements appear in quotation marks.

D000043592 en n —.MAP120 — Parameter Editor — User Manual
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1 Overview

The Landis+Gyr .MAP120 Parameter Editor supports services needed to edit and
download complete device descriptions (parameterisations) into the supported
Landis+Gyr devices.

The following diagram illustrates the various fields of application of the
Landis+Gyr MAP and .MAP Tools.

e

tlnstallation ’iReadout } t Maintenance ’
MAP190/120

.MAP110 .MAP100
.MAP120

1.1 Functions

Test +
Verification

Parameter-

Configuration S TF
isation

The Landis+Gyr .MAP120 Parameter Editor supports the following main use cases:

1. Creating a device description file for manufacturing and documentation
purposes

2. Changing parameters of a connected device (e.g. at utility central services)

The range of functions comprises:
e Create and edit device descriptions
e Read complete device descriptions from devices

e Write complete device descriptions or specific parameter groups (e.g. time of
use, security system) to devices and execute related actions (e.g. clock setting,
register reset)

e Save and open complete device descriptions
e Print device descriptions

e Compare two device descriptions

1.2 Communication channels

The Landis+Gyr .MAP120 Parameter Editor can communicate with the devices via
the following communication channels:

e Serial: Optical reading head, Bluetooth reading head, RS232, R$485, CS, M-Bus
e Modem: PSTN, GSM
e Network: GPRS, Ethernet

D000043592 en n —.MAP120 — Parameter Editor — User Manual © Landis+Gyr
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1.3

1.4

1.5

1.6

Landis+Gyr

Overview

Communication protocols

The Landis+Gyr .MAP120 Parameter Editor supports the following communication
protocols:

dims security

dims / HDLC

dims / TCP (wrapper) with IPv4 and IPv6
dims / UDP (wrapper) with IPv4 and IPv6
IEC 62056-21 (formerly known as IEC 1107)

The Landis+Gyr .MAP120 Parameter Editor supports the following dims security
features:

Editions

dlms access security (low level and high level security)

dlms message security (security suite 0)

The Landis+Gyr .MAP120 Parameter Editor is only available in a Standard Edition.

Supported devices

Please refer to the read-me file (see section 7.9 "Displaying release notes") for a
list of supported devices.

D000043592 en n —.MAP120 — Parameter Editor — User Manual
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2 Installation and Uninstallation

This section describes the installation of the Landis+Gyr .MAP120 Parameter
Editor on your PC and its uninstallation if it is no longer used.

2.1 Installation

System requirements To be able to run the Landis+Gyr .MAP120 Parameter Editor, your PC must be
equipped with the operating system Windows 10, Windows 8, Windows 7 or
Windows Vista.

For 64 bit operating systems dedicated hardware drivers (e.g. for the optical head
or other communication equipment) might be needed. Please contact the vendor
of your devices to obtain a driver update, if necessary.

Additionally, the following system component, which is not part of the Landis+Gyr
.MAP120 Parameter Editor, must be installed on your PC:

e NET Framework Version 4.6.1 or later

Administrator privileges  Administrator privileges on your computer are required for the installation and
the licensing.

Installation software The installation software for the Landis+Gyr .MAP120 Parameter Editor can be
downloaded to your PC via the Internet from the Landis+Gyr homepage
www.landisgyr.eu. Please contact your sales representative to receive the
required username and password for the download.

Language The required language must be selected at installation time. It can be changed
again at any time in the Landis+Gyr .MAP120 Parameter Editor.

Preparation Please read the file "dMAP120_Readme.txt" with current information about the
present release of the Landis+Gyr .MAP120 Parameter Editor.

First installation Start the installation file "Setup.exe" and then follow the instructions of the setup
wizard.
Upgrades Close the Landis+Gyr .MAP120 Parameter Editor, if it is in use. Then start the

installation file "Setup.exe" and follow the instructions of the setup wizard.

When upgrading a former release 4.5 to the latest release 4.5, the former release
will be automatically replaced by the newer one. All data including the license and
the communication settings is kept.

When upgrading a former release 2.x, 3.x, 4.0, 4.1, 4.2, 4.3 or 4.4 to the latest
release 4.5, the new release can be installed in parallel to a former release in a
separate directory. All data including the license and the communication settings
is kept.

Former releases 1.x can't be upgraded.

Landis+Gyr recommends to remove older releases since they will no longer be
supported.

D000043592 en n —.MAP120 — Parameter Editor — User Manual Landis+Gyr
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Installation and Uninstallation

2.2 Uninstallation

If the Landis+Gyr .MAP120 Parameter Editor is no longer needed, it should be
uninstalled.

To do so, open the Windows Control Panel and use "Uninstall a program" from
the "Programs" category.

2.3 Required setting when operating .MAP120 on high resolution displays

On computers with high resolution displays (e.g. UHD with 3840 x 2160 pixels) or
in general when using a Windows display scale factor of more than 150% a special
setting is required to operate the Landis+Gyr .MAP120 Parameter Editor. Without
this setting the tool will appear very small with a scale factor of 100% and can
hardly be used.

The Landis+Gyr .MAP120 Parameter Editor must be started using a link in which
the "Disable fullscreen optimizations" checkbox is ticked in the "Compatibility"
tab:

@ Landis+Gyr MAP120 - 4.5 Properties

Security Details Previous Versions
General Shartcut Compatibility

If this program isn't working comectly on this version of Windows,
try running the compatibility troubleshooter.

| Run compatibility troubleshooter I

How do | choose compatibility settings manualky ?

Compatibility mode
Run this program in compatibility mode for:

Windows 8 w

Settings
Reduced color mode

g-bit (256) calar

Rur in 640 x 480 screen resolution
Dizable fullscreen optimizations

[ ] Run thiz program as an administrator

Change high DPI settings

G[ﬁhange settings for all users

QK Cancel Apply

Furthermore the "Override high DPI scaling behaviour." checkbox in the additional
window which appears after clicking the button Change high DPI settings must be
ticked:

© Landis+Gyr
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Landis+Gyr .MAP120 - 4.5 Properties

Choose the high DPI settings for this program.

Program DPI

] |Ise this setting to fix scaling problems for this program
instead of the one in Settings
Open Advanced scaling settings

A program might look blurry if the DPI for your main display
changes after you sign in to Windows. Windows can fry to fix
this scaling problem for this program by using the DPI that's
set for your main display when you open this program,

LIse the DPI that's set for my main display when
I signed in to Windows

Learn mare

High DPI scaling override

Cwverride high DPI scaling behavior,
o
Scaling performed by:

Application W

0K Cancel

Nevertheless a few icons in the application tool bar still will be shown minimized.
But this doesn't affect the usability of the Landis+Gyr .MAP120 Parameter Editor.

It is planned to modify the program so that it will work properly in the future

without this setting.

D000043592 en n —.MAP120 — Parameter Editor — User Manual
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3 Licensing

This section explains the licensing concept and describes the steps necessary for
licensing the Landis+Gyr .MAP120 Parameter Editor.

3.1 Licensing concept

After installation, the Landis+Gyr .MAP120 Parameter Editor is in the unlicensed
state, i.e. it can only be used as demo version with reduced range of functions. In
order to permit the use of the Landis+Gyr .MAP120 Parameter Editor without
restrictions, it must be licensed. For this purpose, the following licensing data can
be obtained from the Landis+Gyr representative responsible, which must be
entered in the Landis+Gyr .MAP120 Parameter Editor:

e User Name
e User Group

e License Key

The procedure is described in section 3.2 "Entering license data".

® MAP120 licence key is not valid for .MAP120
The license key for the former Landis+Gyr MAP120 Parameter Editor cannot be
used for the Landis+Gyr .MAP120 Parameter Editor. A new licence key is required.

The license of the Landis+Gyr .MAP120 Parameter Editor release 2.2 or later is
handled individually per Windows user and per .MAP120 main release on a single
PC. If several persons share the same PC, the required .MAP120 user group with
its specific functionality can therefore be individually assigned to each Windows
user (up to release 2.0 the same license was used for all Windows users of a single
PC and all .MAP120 releases).

When upgrading a former .MAP120 release 2.x to release 2.2 or later the current
license is kept, i.e. it is copied once for each Windows user of the PC from the for-
mer release.

From release 2.1 any license change or a new license only affects the current Win-
dows user and the current .MAP120 main release.

The license conditions remain unchanged, i.e. all existing and new licenses can be
further used by one or several Windows users on one or several PCs. Please note,
that normally the user name in the .MAP120 licence and the Windows user name
are different.

Landis+Gyr D000043592 en n —.MAP120 — Parameter Editor — User Manual
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3.2 Entering license data

This section describes the licensing procedure required for unrestricted use of the
Landis+Gyr .MAP120 Parameter Editor. The license data received from Landis+Gyr
following your order is required for this purpose.

@ Administrator privileges required
Administrator privileges on your computer are required for the licensing.

Procedure:

1. Click on Start and then under All programs select the Landis+Gyr program
group.

2. Right click on the Landis+Gyr .MAP120 - 4.5 command and then select the
entry "Run as administrator" in the popup menu appearing.
The Landis+Gyr .MAP120 Parameter Editor is started.

3. Select License from the Tools menu.

The "License" window appears.

License

User Mame: |Demo User |
User Group: Demo hd
License Key: | |

b

Enter the user name provided by Landis+Gyr in the "User Name" entry box.

v

Select the user group provided by Landis+Gyr in the "User Group" drop down
list.

6. Enter the licence key provided by Landis+Gyr in the "License Key" entry box.

License

User Name: |Henn‘I Miller |

User Group: Standard ~

License Key:  |5034-22FC-C860-2293 |
Conc

7. Click on OK.
The licence data is checked and a success message is displayed.

License X

MMAP120 has been successfully licensed,

Please keep your license data in a safe place for later reuse,

D000043592 en n —.MAP120 — Parameter Editor — User Manual © Landis+Gyr
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Landis+Gyr

Licensing

8. Click on OK.
The licensing procedure is terminated.

The Landis+Gyr .MAP120 Parameter Editor is now ready for use according to the
instructions given in the following sections.

Keep the license key in a safe place

Please note that due to security reasons the license key is not shown anymore if
the "License" window is reopened. Keep the license key in a safe place for further
use.

D000043592 en n —.MAP120 — Parameter Editor — User Manual
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4 Description of user interface and general functions

This section describes the user interface of the Landis+Gyr .MAP120 Parameter
Editor and contains procedures to use its functions.
4.1 Overview

The user interface of the Landis+Gyr .MAP120 Parameter Editor comprises the
following areas:

e Menu bar (1) with menus to select functions.
e Toolbars (2):
— Application toolbar
— Access level toolbar
— Address toolbar (either phone number or IP address is visible)
— Device toolbar
— Communication channel toolbar
e Device description window:
— Tree view of device description (3)
— Detail view of device description (4)
— Status bar of device description (5)
e Communication log (6) for recording and analysing communication activities

e Status bar (7) for displaying data about the current communication status.

7 File View Communication Tools Windows Help 1

J bk His s & Lol v

Device: ZMXi320CQ

Y QAL k "

v  20000: Landis+Gyr E450

Client: [G] Management Access, static password T Phone: s 2 e

= [ IECHDLC |39188839; 9859 ~| 4 Channel: USE - Optical Head - COM3 - 9600 - &

~ . 10000: Device Settings
» =7 10001: Configuration e
.
@ 10153 Network
@ 10156 LED Pulse Output
» =7 10056: Terminals
» = 7 10002: Clock
5 “ 10031 Energy Registers
» ©  10059: Demand Registers
» =7 10250: Tariffication
5 == 10141 Time OFf Use (TOU)
> = 10142: Billing Data
» = 7 10144: Load Profile 1
» =7 10143: Load Profile 2
» = 10080: Multi Utility
> © 7 10481: Event Logs
» © 7 10322: Fraud Detection and Access Supervision
> =7 10147: Quality Of Supply

Device Description ID:  LGZ1030739188859

Firmware Version: V931010

Network (0-0:199.12.0)

Nominal Voltage

Nominal Current

Start Current

Maximum Current

Power Factor Calculation Method

Apparent Calculation Method

Phase Sequence Detection enabled

Phase Sequence Direction

LED Pulse Output (0-0:199.2.0)

Normal Mode
Pulse Constant

Pulse Length

Parameterisation ID:  LGW1040s

230 v
: 4]

A
20 mA
100 A
(0) import
(1) Vectorial

[1) Anticlockwise (L1L2L3)

. | imp/kWh
1000 impfkvarh
2 ms

Type Designation: ZMXi320CQUOL1D3.31 54 e

AV

set State: ODENING
open

wait 200 ms

975154€8ms - HDLC

97515484ms - HDLC
<

§-> SNRM-Frame Srchdr=1 DestAdr=l SendFrSize=243 RecFrSize=243 Poll=True FrameValid=True
§-> TEROLE03035334E2ZB8180120501F80€0LFE07040000000108040000000155BE7E v

Communication Log

o -

W 1490 [ 1491

Session: disconnected 6

The sizes of the areas for the tree view, detail view and communication log can be
set individually with the movable separators situated in between (click separator
and move with mouse button pressed).
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4.2 Menu bar

Description of user interface and general functions

The status bar and the communication log can be faded in or out using the corre-
sponding menu points of the "View" or "Communication" menu.

The menu bar of the Landis+Gyr .MAP120 Parameter Editor contains the following
menus for selecting functions:

Menu Menu entry Description of function
File New... See section 5.1.1 "Creating new device descriptions"
Open... See section 5.1.2 "Opening existing device descriptions"
Save See section 5.1.3 "Saving device descriptions"
Save as... See section 5.1.4 "Saving device descriptions under a
new name"
Close Closes the active device description window
New from OMT file... For LG internal purposes only
Change firmware For LG internal purposes only
version...
Print page setup... See section 5.1.5 "Defining the print layout for device
descriptions"
Print... See section 5.1.7 "Printing device descriptions"
Print preview See section 5.1.8 "Previewing the printout on the
screen"
Exit Terminates the Landis+Gyr .MAP120 application
View Compare to file... See section 5.1.11 "Comparing a device description to a

file"

Compare page

See section 5.1.6 "Defining the print layout for compare

setup... results"
Status bar See section 5.1.9 "Switching the status bar on and off"
Communication Connect Dials the selected phone number to establish a modem
connection
Disconnect Terminates an existing modem connection

Load from device

See section 5.1.10 "Reading device descriptions from a
device"

Send to device

See section 5.3.2 "Starting the parameterisation wizard"

Abort

Interrupts the existing communication session

Communication
settings...

See section 6.2 "Communication settings"

Communication log

See section 4.5 "Communication log"

Tools

ASCII character
converter...

See section 7.1 "Converting ASCII to text or vice versa"

Licence...

See section 3.2 "Entering license data"

Startup language...

See section 7.2 "Changing the language of the user
interface"

Options...

See section 7.5 "Defining storage location of
communication settings"

Landis+Gyr
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Menu Menu entry Description of function

Windows Cascade Arranges windows in an overlapped fashion
Tile vertical Arranges windows in non-overlapped vertical tiles
Tile horizontal Arranges windows in non-overlapped horizontal tiles
Close all Closes all open device description windows

Help Help See section 7.8 "Displaying tool help"
Release notes See section 7.9 "Displaying release notes"
About .MAP120... See section 7.10 "Displaying the current program

release and checking for updates"
4.3 Toolbars
4.3.1 Application toolbar

(=

H o 0N \-._,.!:?gc. ”

The application toolbar contains the following buttons for direct selection of
frequently required functions:

T = G

J-

i

£l

g

8 @ I

Creates a new device description
(see section 5.1.1 "Creating new device descriptions")

Opens a stored device description file
(see section 5.1.2 "Opening existing device descriptions")

Saves the selected device description file
(see section 5.1.3 "Saving device descriptions")
Prints the selected device description

(see section 5.1.7 "Printing device descriptions")

Displays a print preview of the selected device description
(see section 5.1.8 "Previewing the printout on the screen")
Displays the communication settings window

(see section 6.2 "Communication settings")

Fades the command log in or out
(see section 4.5 "Communication log")

Loads the device description (all parameters) from the device
(see section 5.1.10 "Reading device descriptions from a device")

Starts the parameter wizard
(see section 5.3.2 "Starting the parameterisation wizard")

Interrupts the existing communication session

Buttons which are not applicable in a specific situation are disabled and shown in

grey.
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4.3.2 Client toolbar

4.3.3 Address toolbar

4.3.4 Device toolbar

Landis+Gyr

Description of user interface and general functions

-

Client: | [0] Public Access, no authentication ]

The access level toolbar allows selection of the required access level. Only fully
defined access levels are displayed, a level can occur more than once with differ-
ent settings for different devices.

Clicking on ] in the access level toolbar displays the access level settings (see
section 6.2.3.3 "Access levels").

The phone number or IP address drop down lists displayed depending on the
communication settings allow selection of the corresponding entry in the address
book.

@5 Phone |EMQ2EIE HO2 7693001, |" G

The phone number of the required modem can be selected in the "Phone" drop
down list if a modem is selected as communication channel.

Clicking on in the address toolbar makes the connection to the selected
phone number. When the connection is made, the drop down list is blocked and
the icon on the button changes its appearance.

Clicking on in the address toolbar terminates the modem connection.

e |
@ 1B

-

IP Address: | E35C Ethernet Module

The IP address and port number of the required device can be selected in the "IP
Address" drop down list, provided a network card is selected as interface in the
communication profile settings. The phone Icon is deactivated.

Clicking on in the address toolbar displays the selected address book entry.

Clicking on IEI in the address toolbar displays the address book (see section
6.2.4 "Address data").

Device: | ZMX310G |"|||7 [EGHDLC | 12129973 ;10973 - &4

The device toolbar allows the selection of devices with predefined settings (device
series and device addresses).

With the checkbox "IEC;HDLC" you can deactivate and again activate the device
address and in the drop down list you can select all defined device addresses.

Device: |EMK31EIG |"| [] I[ECGHDLC |12129973 ;10973 ~|&@

Clicking on in the device toolbar displays the device settings (see section
6.2.3 "Device data").
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4.3.5 Communication channel toolbar

-

Channel: |U5-E - Optical Head - COM3 - 9600

5

The communication channel toolbar allows the selection of communication chan-
nels with predefined settings (e.g. interface, transmission protocols etc.).

Clicking on in the communication channel toolbar displays the channel set-
tings (see section 6.2.2 "Communication channel data").

4.4 Device description window

The device description window shows the parameters of a device. Normally it is
shown maximised, i.e. it uses the entire space in the .MAP120 Parameter Editor.

& MAP120 - [LGZ1030739188859 (V931010)7]

* File View Communicstion Tools Windows Help

DLHS&: @2 (o Client: [G] Management Access, static password - & @& Phone - 5]
Device: ZMXi3200Q - [1IECHDLC 391882509859 ~| 4 Channek USE - Optical Head - COMS - 9600 - i
k4

¥ QA k 4

« 7 20000: Landis+Gyr E450

Metwork (0-0:199.13.0)
~ _ 10000: Device Settings

> £ 10001: Configuration Nominal Veltage 230 v
v Nominal Current 5 A
@ 10155 Network
@ 10156: LED Pulse Output
5“7 10056: Terminals Maximum Current 100 A
» =7 10002: Clock
5 == 10031 Energy Registers
> © 7 10059: Demand Registers
» O 10250: Tariffication Phase Sequence Detection enabled
» © 7 10141 Time Of Use (TQU)
>
>
>
>
>
>

Start Current 20 mA

Power Factor Calculation Method (0) import

Apparent Calculation Method (1) Vectorial

Phase Sequence Direction (1) Anticlockwise (L1L2L3) ~
£ 10142: Billing Data

77 10144: Load Profile 1

LED Pulse Output {0-0:199.2.0)
7% 10143: Load Profile 2

<7 10080: Multi Utility Nermal Mode
1048% Event Logs Pulse Constant 1000 ~ ‘mp'f::vhh
% 10322: Fraud Detection and Access Supervision impy/kvarl
> 57 10147: Quality Of Supply Pulse Length 2 ms

Device Description ID:  LGZ1030739188859 Firmware Version: V221010 Parameterisation ID: LGW1040s Type Designation: ZMXi320CQUOL1D3.31 54

Session: disconnected 1 1490 [ 1491

Clicking the button in the upper right corner of the .MAP120 downsizes the
device description window, so that more than one device description window can
be displayed at once. Using the entries "Cascade" or "Tile" from the "Windows"
menu allows automatic arrangement of windows.

* LGZ1030739188259 (V931010) =N ==
x4 QA bk k (1] r (4)
w _ 20000: Landis+Gyr E450
~ . 10000: Device Settings
3 =7 10001: Configuration 9 Nominal Voltage 6 230 v
» = 10140: Network
» © 7 10056: Terminals
5 5 10002: Clock
5 <77 10031 Energy Registers Maximum Current 100 A
» = 10059: Demand Registers
»
>
>
b
>

MNetwork (0-0:199.13.0)

Nominal Current 5 A

Start Current 20 mA

Power Factor Calculation Method (0Q) impart
= 10250: Tariffication

7 1014%: Time Of Use (TQU)
© 7 10142: Billing Data 9 Phase Sequence Detection enabled
=7 10144: Load Profile 1
7 10143: Load Profile 2

Apparent Calculation Method (1) Vectorial

Phase Sequence Direction (1) Anticlockwise (L1L2L3) ~

Device Description ID:  LGZ1030739188859 Firmware Version: V931010 Parameterisation ID:  LGW1040s @ Type Designation:  ZMXi320CQ

1 Toolbar of tree view
2 Tree view
3 Movable separator

4 Toolbar of detail view
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Description of user interface and general functions

Tree view toolbar

Tree view

5 Detail view (detailed view of selected tree items)

6 Status bar of device description

Device description windows are divided into two by a movable separator (can be
moved by clicking and shifting the separator). The tree view on the left side of the
window contains a general tree representation, while the detail view on the right
side displays details of the currently selected tree item (parameter or folder).

Both sectors of the window have horizontal and/or vertical picture scrolling func-
tions if part of the window half cannot be seen. Scrolling does not affect the focus.

Clicking the button in the upper right corner of a downsized device descrip-
tion window maximises the device description window again.

The toolbar of the tree view contains the following elements:

N?‘.I Displays the online help for the device displayed in the tree
(details see below under "Displaying device help")

ﬂ Zooms the content of both sectors of the device description window
in a range from 1.00 to 3.00 in steps of 0.20:

o Fully left = magnification factor 1.00, i.e. original size
e Fully right = magnification factor 3.00, i.e. 3 times bigger size

q Allows a full text search in the tree (details see below under "Full text
search in tree view")
" Expands all folders of the tree
" Collapses all folders of the tree

A tree view, e.g. as generally familiar from the file system tree of Windows
Explorer, is ideally suited for navigating in ordered structures with folders and
subfolders.

M s 000 i o i3

+ _ 10000: Device Settings
w 10001 Configuration
10207 Configuration
L}ﬁ] 10212: Channel Number of Energy and Demand Registers
= 10140: Network
@ 10155 Network
@ 10136: LED Pulse Qutput
= 10056: Terminals
| 4] 10057 Digital Input
L}ﬁ:l 10216: Output 1
L}ﬁ] 10293: Qutput 2
= 10416: Output Control
7 10002: Cleck
¥) 10003: General Clack Configuration
¥) 10004: Clock Synchronisation
¥) 10006: Daylight Saving Time Settings
w 10031 Energy Registers
Ljﬁ] 10235: Test Mode
=7 1032T: Energy Total Registers
= 10328: Rated Energy Registers
= 10059: Demand Registers

Landis+Gyr
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Tree items

Folder handling

For the Landis+Gyr .MAP120 Parameter Editor the tree consists of a hierarchical
arrangement of tree items (folders and parameters).

Tree items are shown as follows:

Folder

Configuration parameters
Network parameters

Clock parameters

Time of use parameters
Communication parameters

Other parameters

Each folder can be expanded and collapsed individually.

Collapsed folder items are preceded by an expansion icon *, expanded folder
items by a collapse icon w.

To expand or collapse individual folders there are the following possibilities:

Using the mouse:

Clicking on the expansion icon * of a folder expands this folder
(the expansion icon * changes to a collapse icon w).

Clicking on the collapse icon w of a folder collapses this folder
(the collapse icon w changes to an expansion icon »).

Double-clicking on a closed folder icon - or on the folder name behind the
icon expands or collapses this folder.

Using the keyboard:

Pressing the [*] key of the numerical keyboard expands the whole tree of the
selected folder (i.e. subfolders in the folder will also be expanded).

Pressing the [+] key of the numerical keyboard expands the selected folder,
but doesn't expand its subfolders.

Pressing the [-] key of the numerical keyboard collapses the selected open
folder or the next higher folder if a closed folder was selected.

Using the buttons in the tree view toolbar:

Clicking on - expands all folders of the tree.

Clicking on - collapses all folders of the tree.
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Detail view of device
description

Detail view toolbar

Device description status
bar

Displaying device help

Landis+Gyr

Description of user interface and general functions

Details of the selected parameter in the tree are displayed in the right-hand part
of the device description window where the parameters can be edited in the
corresponding fields.

™ L671030739128850 (V931010) =2 =R ="
¥ QAR k r
+ = 20000: Landis+Gyr E450

~ _ 10000: Device Settings

% 10001%: Configuration Time Base (1) internal crystal

General Clock Configuration (0-0:1.0.0)

7 10140: Network Deviation of Local Time to UTC |-60 min @
= 10056: Terminals
W 10002: ClocK Clock Synchronisation (1-0:0.9,11)

¥) 10003: General Clock Configuration
Synchrenisation Lock 1hour *

¥) 10004: Clock Synchronisation

Maximum Time Shift without Registration

W) 10006: Daylight Saving Time Settings
-~ of a Clock Adjusted Event =

=7 10031 Energy Registers

Device Description ID:  LGZ1030739188859 Firmware Version: 931010 Parameterisation ID: LGW1040s Type Designation: ZMXi320CQUOL1D3.3

.*
The toolbar of the detail view contains the folder up button . Clicking on this
button selects the next higher folder above the currently selected tree item.

The status bar below the device description displays the following device descrip-
tion values:

Device Description ID

e Firmware Version

Parameterisation ID

e Type Designation

Note: In newly created device descriptions the Device Description ID and the Para-
meterisation ID are still undefined.

3

Clicking on <+ in the toolbar of the tree view of the device description window
displays the online help for the opened device description. These help texts corre-
spond to the contents of the device functional description.

Find the desired information. Since the help function is a standard Windows func-
tion, it will not be explained at this point. More details are found in the Windows
manual belonging to your PC.
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Full text search in
tree view

With the search function you can perform a full text search in the tree view of the
device description window (Note: The detail view of the device description window
is not included in the search).

Procedure:

1.

Click on q in the tree view toolbar.
The "Find .MAP120" window appears.

Find .MAP120 - [LGZ1030739188859 (V831010) (2)*]

all nodes containing N

Find what

Q Fing

ignore case

Results ()
Node Text
2. Enter the term you want to find in the entry box.

If you have already carried out searches previously, you can click on the
arrow behind the entry box and select one of the previous terms in the
appearing list. The terms remain in the list until the program is terminated.

Deactivate the check box "ignore case" if the search shall be case sensitive.
In the selection field select

— containing to search for the term at any place within the tree text,

— starting with to search for the term at the beginning of the text or

— ending with to search for the term at the end of the text.

Click on "Find".

The search result is listed in the "Results" area.

In the example shown with the term "time" and the attributes "containing"
and "ignore case" all folders and elements containing the term "Time" are
listed.

Note that the whole text is considered, including the item number. Therefore
a search for "time" with attribute "starting with" would not show any result,
whereas a search for "time" with attribute "ending with" would show for
instance the element "10240: Billing Period Reset Lockout Time" since here
the term "Time" appears at the end of the text.
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Find .MAP120 - [LGZ10307397188859 (V931010

Find what

all nodes containing N

time |E|

ignore case

Q Find

Results ()

Node Text

1 10006: Daylight Saving Time Settings

2 Folder 10141: Time Of Use (TOU)

3 10239: Time Of Use

4 10240: Billing Period Reset Lockout Time

5 Folder 10484: Time of Use and Tariff Management
] 10426: Time of Use and Tariff Management

Close

6. Click on aresult line in the list to highlight the corresponding folder or
element in the tree (the folder containing the element is automatically
expanded).

1010) e (=@ =]
Find .MAP120 - [LG
n
« " 20000: Landis+Gyr E450 Find what
+ = 10000: Device Settings all nodes LT

3 £ 10001: Configuration
3 == 10140: Network time
3 £ 10056: Terminals ignore case
« = 10002: Clock

(&) 10003: General Clock Configuration =i

.:') 10004: Clock Synchronisation £

() 10006: Daylight Saving Time Settings Node Text
» [ 10031: Energy Registers 1 10006: Daylight Saving Time Settings
» T 10059: Demand Registers 2 Folder 10141: Time Of Use (TOU)
» T 10250: Tariffication 3 10239: Time Of Use
» T 10141: Time Of Use (TOU) 4 10240: Billing Period Reset Lockout Time
» T 7 10142: Billing Data 5 Folder 10464: Time of Use and Tariff Management
» T 7 10144: Load Profile 1 3 10426: Time of Use and Tariff Management
3 £ 10143: Load Profile 2
3 £ 10080: Multi Utility
3 7 10481: Event Logs
3 £ 10322: Fraud Detection and Access Supervision
3 £ 10147: Quality Of Supply
% % 10148: Disronnector e | ‘

Device Description ID:  LGZ1030739188859 Firmware Version: V931010 | Parameterisation ID: LGW1040s  Type Designation: ZMXi320CQUOL1D331 54
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4.5 Communication log

CD Additional knowledge required
Additional knowledge is required to analyse communication activities.

Clicking on in the application toolbar shows or hides the communication log,
where all communication activities can be traced and analysed.

First, the trace level has to be adjusted for each trace type supported as follows:

1. Clickon in the communication log toolbar.
The ".MAP120 - Communication Tracers" window appears.

Communication Tracers X

COSEM Trace |on w
DLMS Trace | medium b
GATEWAY Trace |low w
LLC Trace |low v
WRAPPER Trace |medium v
HDLC Trace |medium v

IEC Trace | medium v

Cancel

2. Selectin the "COSEM Trace" drop down list whether the COSEM Trace shall be
on or off.

3. Selectin the other drop down lists the resolution of the DLMS, GATEWAY, LCC,
WRAPPER, HDLC and IEC tracers (low, medium, high) or switch them off.

4. Click on OK.

All communication activities are traced in the communication log according to the
settings made.

HE X @O e AW Communication Log
57731500ms - DLMS R<- block: 2 last block: True  020412000405060004180205FF0F02120000020412000405060004150% a
57731500ms - DLMS R<- 0COL00010A0204120008050600000L0000FF0F02120000020412000109060004€00A03FFOF021200000204120¢
97731500ms - DLMS set State: OPEN

27731671lms - COSEM  Clear Command List(s)

27731718ms — DLMS set State: CLOSING

57731718ms — HDLC Close

57731718ms - HDLC S-> DISC-Frame SrcAdr=l DestAdr=1 Poll=True FrameValid=True

37731718ms - HOLC 5-> 7ER00703035380D77E

97731796ms — HDLC R<- TERO0S030373C058470F7E

277317%6ms - HDLC R<- UA-Frame SroRdr=l Desthdr=l SendFrSize=0 RecFrSize=0 Poll=True FrameValid=Trus

277317%6ms — DLMS set State: CLOSZD v
< >

To analyse a specific string, mark it and click on . in the communication log
toolbar. This opens the ".MAP120 - Protocol Analyzer" window.
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Protocol Analyser

©1258R10906076058574050801022203020100A305R103020100BEOF040D0500065F04001C122017T0OFROD

Analyse

DLMS PDU  Gateway LLC HOLC Frame Wrapper Ciphered APDLU
with additional field information Identifier Length Value

DIMS PDU[S7] {** RpplicationRhsscciationResponse *%} ~
ApplicationfsscciationResponse Sequence
[1] applicaticn-context-name

CObjectldentifier ::= Segquence0f & Element(s)
0: Unsigned32 = 8¢ (0x000000€0) [**% joint-iso-cecitt, country %]
1: Unsigned32 = 756 ({0x000002F4) {** country-name *¥}
2: Unsigned32 = 5 (0x00000005) {** identified-crganization **}
3: Unsigned32 = & (0x00000008) [*% DLMS-UL **}
4: Unsigned32 = 1 (0x00000001) {** application-context **}
5: Unsigned32 = 2 (0x00000002) {** Short_Name Referencing no ciphering **}

[2] result
RAssociaticnBResult = 0 {accepted)
[3] result-scurce-diagnostic
RssociateSourceDiagnostic[l] [*¥% RcseServicelUser **}]
Integerd = 0 (0x00) {null)
[30] user-information (InitiateResponse)
Octet3String[l3] = 0800065F04001C12201770FRD0

DLMS PDU[E] [** initiateResponse *¥]
InitiateResponse Sequence
Optional Flag = False {** negotiated-quality-of-service **}
Unsigneds = & (0x0&) {** negotiated-dlms-version-number **}
Conformance[24] = 000001000100100000111000 {** negotiated-conformance %%}
Bit(23) =0 [** action **} ~

Save as... Close

Clicking on EI in the communication log toolbar opens the "Open Communica-
tion Log" dialogue window to display logs previously saved again. Clicking the
right mouse button in the communication log followed by selection of the Open
Log File menu item in the pop-up menu appearing has the same effect.

Clicking on in the communication log toolbar opens the "Save as" dialogue
window to save the log displayed in a freely selected directory either as RTF file
(default) or as text file. Clicking the right mouse button in the communication log
followed by selection of the Save as menu item in the pop-up menu appearing has
the same effect.

Clicking on in the communication log toolbar copies the content of the com-
munication log to the Windows clipboard, from where it can be inserted into an-
other application (e.g. in a word processing program). Clicking the right mouse
button in the command log followed by selection of the Copy all menu item in the
pop-up menu appearing has the same effect.

Clicking on in the communication log toolbar deletes the communication log.
Clicking the right mouse button in the communication log followed by selection of
the Clear menu item in the pop-up menu appearing has the same effect.

© Landis+Gyr D000043592 en n —.MAP120 — Parameter Editor — User Manual



Description of user interface and general functions 27/132

Full text search

4.6

Status bar

With the search function you can perform a full text search in the communication
log window.

Enter the term you want to find in the entry box of the toolbar (the search is not
case sensitive) and then click on ¥ or & for searching downwards or upwards
starting from the currently marked position in the communication log window.
The first occurrence of the searched term is highlighted.

Example: Searching the term "auth" finds as first occurrence the DLMS entry "set
State: AUTHENTICATION".

HBHE XE auth AV Communication Log
57515250ms - DLMS set State: ODENING ~
57515250ms - HDLC Open

57515250ms - HDLC wait 200 ms

575154€8ms - HDLC §-> SNRM-Frame SrcAdr=l DestAdr=l SendFrSize=248 RecFrSize=245 Poll=True FrameValid=True
97515484ms - HDLC 5-> 120303934E2B5150120501F50601F50704 108040000000155BE€7E

97515531ms - HDLC R TERO1EO303934E2BB180120501F80€01F3070400 000108040000000155B&7E

597515521lms - HDLC R<- SHMRM-Frame SrcRhdr=l Desthdr=l SendFrSize=242 RecFrSize=248 DPoll=True FrameValid=True

S975155231lms - HDLC EchoHandler on

97515625ms — HDLC R<— T7ER020030373F02ES18014050200280060200F807040000000108040000000187CB7E

57515€625ms — HDLC R<— UAR-Frame Srchdr=1 Desthdr=1 SendFrSize=125 RecFrSize=245 Poll=True FrameValid=True
97515€25ms — DLMS set State: BUNENTICATION w
< >

Clicking again on ¥ or & searches for further occurrences of the term.

Session: busy (dlms - COMS - 9600 bps) B 255 [ 256 ||
The following data is normally displayed in the status bar:

e Session information, e.g. connected, busy or disconnected

e Protocol, port and transmission rate (in parentheses)

e Number of objects sent (blue) and received (green)

e Data indication (running from left to right while data is transmitted)

Communication Settings: loaded B o0

During and after editing communication settings the status bar shows information
about the communication settings, e.g.

e loading (while loading)

e |oaded (while the communication settings are displayed for editing)
e saving (while saving)

e saved (after editing the communication settings)
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5

5.1

5.1.1

Device description functions

The Landis+Gyr .MAP120 Parameter Editor is used to edit and download complete
device descriptions (parameterisations) into supported Landis+Gyr devices.

General functions
This section describes general functions selectable in the menus of the menu bar
(see section 4.2 "Menu bar").
Creating new device descriptions
New device descriptions can be created for any supported device firmware ver-
sion from templates available in the .MAP120 application.
Procedure:
1. Clickon in the application toolbar or select New from the File menu.
The "New Device Description" window appears.

2. Select the device series, the type and the firmware version.

New Device Description x

Device Series Type Firmware
) E35C ) ZCXil00Q /94,00.00
) E380 ® ZMXi3000 V93,1212
@ E450 54 YE311.15
V93.11,11
() E450 53/52

) 93.10.10
) E450 51 /93,0603
) E460 ¥93.05.02
(O E570 V93,0401
) L540 4a3.03.01
o 93,00,00

3. Click on OK.

The selected device description is created and loaded into the .MAP120

Parameter Editor.

During this operation, an indication in the device description window informs
about the step in progress, e.g. "Loading tree".

© Landis+Gyr
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4 MAP120 - [Device Description (¥931212)°

™ File View Communication Tools Windows Help - 8 X

L H & &% @ 5) o O " Client: [0] Public Access, no authentication v & & Phune:|:| LJ
Device: Default Device = [ IEGHDLC |-: 10005 ~| 4 Channel: CommunicationChannel - &%

Updating device model

Communicaticn Settings: loaded ||\"v 0 ”‘L} 0 |

Afterwards, the selected device description is displayed in the .MAP120 Para-
meter Editor.

4 MAP120 - [Device Description (¥331212)*]

* File View Communication Tools Windows Help - F X

L H GG @D oo " Client: [0] Public Access, no authentication v & & Phane:|:| [ ]
Device: Default Device = [ IEC:HDLC |-: 10005 =| 4 Channel: CommunicationChannel - &

Y QUL b r
« = 20000: Landis+Gyr E450 ~ |
~  10000: Device Settings
= 10001: Configuration £ 20001: Logistics

>
5 © 7 10140: Network = 0002: MAP
5 © 7 10056: Terminals

5 57 10002: Clock

» T 10031: Energy Registers

» = 1005%: Demand Registers

5 © 7 10250: Tariffication

5 © 7 10141 Time Of Use (TOU)

» = 10142: Billing Data

» =7 10144: Load Profile 1

» = 10143: Load Prefile 2

» = 10481: Event Legs

?

= 10322: Fraud Detection and Access Supervision W
Device Description ID: Firmware Version: V931212 Parameterisation 1D Type Designation: ZMXi310CQUOLOD3.21 54
Communication Settings: loaded ||G 0 ”-L} 0 |

4. Perform the intended work with the device description: You can edit the
parameters of the device description (see section 5.2 "Editing parameters"),
save it (see section 5.1.3 "Saving device descriptions") or write it into a de-
vice (see section 5.3.1 "Parameterisation wizard").
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5.1.2 Opening existing device descriptions

Existing device descriptions can be opened in the .MAP120 Parameter Editor.

Procedure:

Click on EI in the application toolbar or select Open from the File menu.

The "Open" window appears (this is an operating system dialog window and
therefore the dialog language depends on the version of your Windows user
interface).

@ Open Device Description

« v g <« V41 » ZeroSeries » Device configuration » E35C module » Standard O series config » v O Search Standard 0 series config @
Qrganize * Mew folder =z ~ [ o
@ Documents A MName - Date modified Type Size

I Deskeop o AT 29.10.2018 18:26 File folder
@ E450 Steiermark g] Oseries V4.1_CUT1G150(V54) xml XML Document
@ DC250 & Oseries V4.1_FUT15G15B(V54) xml XML Document
o) B3601TE & Oseries V4.1_FUT15G150(¥54)aml XML Document
& Documentation gj Oseries V4.1_GG11G15B(V54) xml XML Document
Q] Oseries V4.1_GUT1G13B(V54).xml XML Document
@ FlexMedule .
@] Oseries V4.1_GUT1G150(V54) xml XML Document
) EELEEEEE U QJ EKZ_E35C_config_260820715 (V540100).xml XML Document 272
@/ LTENB1 & M1 Trials 2018 &1 TimeOfUsexml XML Document 8
@ E450 Vader
@  Quality issue 2019
@ Tenders
@ Temp
4 Downloads
= Pictures v £ >
File name: v| Device Description files ("xml)
2. Select your personal data folder in the displayed tree structure if it is not
already displayed.
3. Double-click on the desired entry in the list or select it and then click on Open.
The selected device description will be loaded and displayed.
It is also possible to select a recently opened device description from the MRU
(most recently used) list in the File menu. This list contains as maximum the
last 6 opened file names. Clicking on a list entry opens the corresponding
device description directly.
-

1 Mew..

|.  Open..

kH  save
Save as...
Close

File | View Communication Tools Windows Help

Mew from OMT file...
Change firmware version...
Print page setup...

<& Print..

2 Print preview

1 ChlUsershuser\DocumentsiLandis+ GyridMAP 12004, 5\ Device Description (V931212).xml

2 C\Users\user\Documents\Landis+ Gyr\dMAP1200\4.5\ Device Description (E360A01).aml

3 ChUsershuser\DocumentstLandis+ GyrdMAP12004.5\ Device Description (V341117 ).xml
4 C\Users\user\Documents' Landis+ Gyr\ dMAP12004.4\ Gerdtebeschreibung (V40000).xml

Exit

The device description just opened becomes the active window.

© Landis+Gyr
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5.1.3

# MAP120 - [Device Description (E360A07)xml]

File  View Communication Tools Windows Help
DL HSGRE2 e Client: [G] Management Access, static password v & Phone: © L
Device: ZMEi320CQ ~ [] IEC;HDLC |39188859; 9859 v| & Channel: USB - Optical Head - COM3 - 9600 - &
™ LGZ1030739188859 (V931010)xm ===
Y QAh k& P
w _ 20000: Landis+Gyr E450
== 10000: Device Settings Daylight Saving Time Settings (0-0:1.0.0)
» 7| ™ Device Description (E360A01)xml =N EER=<=
; | QAR k P
- | 10000: Device Settings

+ _ 10000: Device Settings
=7 10001: Configuration = 20001: Logistics
= 10740: Network

| 20002: MAP
= 10056: Terminals

Device Des % 10031 Energy Registers

Session; disconnected

=7 10059: Demand Registers
=7 10250: Tariffication
5 5710141 Time Of Use (TOU)

>
>
>
> 577 10002: Clock
>
>
>

Device Description 1D: Firmware Version: E360A01 Parameterisation ID: Type Designation: E360-AD2D.C3D.B2-L1PTWLD1

1490 || 1491

4.

Perform the intended work with the device description: You can edit the
parameters of the device description (see section 5.2 "Editing parameters"),
save it (see section 5.1.3 "Saving device descriptions") or write it into a de-
vice (see section 5.3.1 "Parameterisation wizard").

Saving device descriptions

Complete device descriptions can be saved in device description files under the
original name. If the device description was newly created or is to be saved under
a new name, you have to proceed as described in section 5.1.4 "Saving device
descriptions under a new name".

Procedure:

1.

Activate the window with the device description to be saved.

Click on in the application toolbar or select Save from the File menu.

If the device description was modified since it was last saved (recognisable
by the asterisk in the title bar) the modified data will overwrite the previ-
ously stored data without any warning.

If the device description was not modified (no asterisk in the title bar) it will
not be saved again.

If a new device description has not yet been saved, it will be saved using the
"Save As" function described in the next section.

D000043592 en n —.MAP120 — Parameter Editor — User Manual

Landis+Gyr



32/132

Device description functions

5.1.4 Saving device descriptions under a new name

Complete device descriptions can be saved under a new name.

Procedure:

1. Activate the window with the device description to be saved under a new
name.

2. Select Save As from the File menu.
The "Save as" window appears (this is an operating system dialog window
and therefore the dialog language depends on the version of your Windows
user interface).

3. Select the desired data folder in the displayed tree structure if it is not

already displayed.
A list of all stored device description files of the same type will be shown.

& Save Device Description As

J 3D Objects

&« v <« V41 » ZeroSeries » Device configuration » E35C module » Standard 0 series config » v B Search Standard 0 series config 0
QOrganize v New folder = - 0
@ Back up settings ) Name Date modified Type
@ Desktop @ ALT 25.10.2018 File folder
@ Documents Qj Oseries V4.1_CU11G1500v54).xml 5 XML Document
@ Microsoft Teams Chat Files Qj Oseries V4.1_FUT1G15B(V54).xml 5 XML Document
Oseries V4.1_FUT1G150(V54) xml 5 XML Document
I This PC e B ’

@] Oseries V4.1_GG11G15B(V54).xml
@] Oseries V4.1_GU11G15B(V54).xml

XML Document

XML Document

[ Desktop & Oseries V4.1_GU11G150(V54) xml XML Document
|= Decuments @] EKZ_E35C_config_26082015 (V540100)xml XML Document
; Downloads @] TimeOflUsexml XML Document
J Music
&=/ Pictures
Videos
s Windows (C:) w € >
File name: | Device Description (V541111) xml o
Save astype: Device Description files (*.xml) ~
~ Hide Folders Cancel
4. Enter the desired name for the device description in the entry box "File
name".
If the device description was newly created, the proposed name corresponds
to the connected device. Otherwise the name formerly used is proposed.
You can overwrite this proposal.
5. Click on Save.

The device description will be saved. The device description name in the title
bar changes according to the selected name.

© Landis+Gyr
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5.1.5 Defining the print layout for device descriptions

The "Print page setup" function allows you to determine the desired page layout
for printouts of a device description.

Procedure:

1. Select Print page setup from the File menu.
The "Page Setup" window appears (this is an operating system dialog win-
dow and therefore the dialog language depends on the version of your Win-
dows user interface).

Page Setup

Paper

Size: Ad (210 297 mm) i
Source: Auto w
Orientation Marging {millimeters)

(®) Portrait Left: Bight:
(") Landscape Top: Bottom:

Cancel

2.  Make the required settings.

3. Click on OK.
This terminates the page setup for printing. You can now perform a print
preview on the screen (see section 5.1.8 "Previewing the printout on the

screen") or start the printout directly (see section 5.1.7 "Printing device
descriptions").
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5.1.6 Defining the print layout for compare results

The "Compare page setup" function allows you to determine the desired page
layout for printouts of the compare results.

Procedure:

1. Select Compare page setup from the View menu.
The "Page Setup" window appears (this is an operating system dialog win-
dow and therefore the dialog language depends on the version of your Win-
dows user interface).

Page Setup

Paper

Size: Ad (210 x 257 mm) i
Source: Auta w
Crientation Margins {millimeters)

(O Partrait Left: Right:
(®) Landscape Top: Bottom:

Cancel

2. Make the required settings.

3. Click on OK.
This terminates the page setup for compare results. You can now display a
compare preview on the screen (see section 5.1.11 "Comparing a device
description to a file") and start the printout directly from there.
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5.1.7 Printing device descriptions
The "Print" function prints out the device description in the predefined form (see
section 5.1.5 "Defining the print layout for device descriptions").
Procedure:

1. Activate the device description window you want to print.

& MAP120 - [Device Description (V931212)7]

* File View Communication Tools Windows Help - x
Ol H & @2 oo Client: [0] Public Access, no authentication - & & Phone:l:l I
Device: Default Device = [ IEC;HDLC |- : 10005 = 4 Channel: CommunicationChannel - &
¥ QA K k ?

v 20000: Landis+Gyr E450 A | — 10007: Confiauration ~

99w 10000: Device ling
5 577 10001: Configuration T 10140: Network

~ o 10140: Network
) 10155 Network
@ 10156: LED Pulse Output £ 10002: Clock
~ o 10056: Terminals
10057: Digital Input
10216: Output 1 = 10059: Demand Registers
10293: Output 2
» = 10416: Output Control

= 10056: Terminals

T 10031: Energy Registers

£ 10250: Tariffication

v [ 10002: Clock £ 10141: Time Of Use (TOU)
.i) 10003: General Clack Configuration .
.i) 10004: Clock Synchronisation 10142: Billing Data
.:) 10006: Daylight Saving Time Settings == 10144; Load Profile 1

3 © 7 10031 Energy Registers

3 7 10059: Demand Registers 10143: Load Profile 2

Device Description ID: Firmware Version: V031212 Parameterisation ID: Type Designation: ZMXi310CQUOLOD3.21 54
Communication Settings: loaded [® o] o]

2. Select Print from the File menu.
The "Print" window appears.

Clicking on £ in the application toolbar would start printing immediately
without displaying the "Print" window.

3. Make the necessary settings (number of pages and copies).

!;! Print
General
Select Printer
i CHZUGPrint on CHZUGY545 M Microsoft XPS Documen
2 Fax M OneNote
M Microsoft Print to PDF [ 5Send To OneMote 2016
< >
Status: Paused Preferences
Location: Zug, Switzedand
Comment: Find Printer. ..
Page Range
@Al Number of copies: |1 =
Selection Current Page
Lo13 5513
Enter either a single page number or a single 1 1
page range. For example, 512
Print Cancel Apply
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4. Click on Print.

The device description is printed out on the selected printer as defined by
default.

If desired, the print layout can be changed individually (see section 5.1.5
"Defining the print layout for device descriptions").

A preview prior to printing can also be performed (see section 5.1.8
"Previewing the printout on the screen").

5.1.8 Previewing the printout on the screen

The "Print Preview" function allows you to check the result of the page setup by
previewing the printout on the screen prior to printing.

Procedure:

1. Activate the device description window you want to preview on the screen.

2. Clickon in the application toolbar or select Print preview from the File
menu.

The "Print Preview" window appears.

& Print Preview - [Device Description (V931212)%] = O

1E14E Kahwark

Type text to find... “«r _

-

The parameter designations are listed in the left column, the parameter values
in the right column.

3. Select the display size by clicking one of the icons in the top line of the
window:

Display original size (100 %)
Display page width

Display whole page

E B [ ES

Display two pages
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* Stepwise increase the display size

= Stepwise decrease the display size

If you are looking for a specific parameter designation or value you can either
navigate to the corresponding position by scrolling with the mouse wheel or
by using the scroll bar or you can use the search function (full text search) in
the bottom line of the window:

Type text to find... L

Enter the text to find in the entry box. Clicking on the blue arrows finds the
next or previous occurrence of the text string and highlights it in the page
preview. In the drop down list behind the blue arrows you can select match
criteria, e.g. match case.

Click on Ly if you want to copy a previously highlighted text section into the
Windows clipboard from where you can insert it into a document using the
insert function [Ctrl]+[V].

Click on "% | if you want to print the device description.

The "Print" window appears (the dialog language depends on the version of
your Windows user interface).

Make the necessary settings (printer selection, printer properties, paper size,
source and orientation) then click on Print.

Close the "Print Preview" window if you don't want to print the device
description.
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5.1.9

Switching the status bar on and off

The "Status bar" toggle function enables you to hide or show the status bar in the
main window of the application.

Procedure:

1. Select Status bar from the View menu.
A tick in front of the menu item indicates that the status bar is currently
switched on. After clicking on the menu item the tick in front of it disappears
and the status bar is no longer visible.

& MAP120 - [Device Description (V931212)7]

™ File View Communication Tools Windows Help - 8 X
" | H [er Wer] \c-.\. ;'J o Client: [0] Public Access, no authentication > & & Phﬂns:l:l L.'
Device: Default Device = [ IEC;HDLC |- ; 1000: ' Channel: CommunicationChannel - &

P QA& k [J
v 20000: Landis+Gyr E450 ~ || == 10001: Configuration ~
98w 10000: Device Settings
3 =7 10001 Configuration & 10140: Network

~ . 10140: Network
) 10155: Network
(@ 10156: LED Pulse Output £ 10002: Clock
~ _ 10056: Terminals
10057: Digital Input
10216: Output = 10059: Demand Registers
10293: Qutput 2
» = 10416: Qutput Control

= 10056: Terminals

T 10031: Energy Registers

1 10250; Tariffication

~ [ 10002: Clock £ 10141: Time Of Use (TOU)
.iv) 10003: General Clack Configuration ~
:) 10004: Clock Synchronisation e e

.:-) 10006: Daylight Saving Time Settings
3 © 7 10031 Energy Registers
» = 7 10059: Demand Registers = 10143: Load Profile 2
3 = 7 10250: Tariffication

T 10144: Load Profile 1

= 10080: Multi Utility

Device Description ID: Firmware Version: V931212 Parameterisation ID: Type Designation: ZMXi310CQUOLOD3.21 54

2. Select Status bar again from the View menu, if you want to show the status
bar (toggle function).
No tick in front of the menu item indicates that the status bar is currently
invisible. After clicking on the menu item the tick in front of it reappears and
the status bar is displayed again.

4 MAP120 - [Device Description (V931212)*]

™ File View Communication Tools Windows Help - 8 X
rN | H [ e ] \g-‘.‘ ‘} O O Client: [0] Public Access, no authentication ~ & & Phone: I:l LJ
Device: Default Device = [] IEC;HDLC |- 10005 - 4 Channel: CommunicationChannel - &
¥ QAR k ?

v 20000: Landis+Gyr E450 ~ || == 10001: Confiquration A
WY W 10000: Device Settings
5 =7 10001: Configuration i 10140: Network

~ o 10140: Network
D 101553 Network
10156: LED Pulse Qutput & 10002: Clock
@ P 10002: Clock
w . 10056: Terminals
10057: Digital Input
10216: Output 1 = 10059: Demand Registers

10293: Output 2
» = 7 10416: Output Control

T 10056: Terminals

= 10031: Ene isters

£ 10250: Tariffication

+ 7 10002: Clock £ 10141: Time Of Use (TOU)
.:) 10003: General Clock Configuration .
.:'-) 10004: Clock Synchronisation e

.iv) 10006: Daylight Saving Time Settings
3 o 10031 Energy Registers

T 10144 Load Profile 1

-
5 ©77 10059: Demand Registers 10143: Load Profile 2
Device Description ID: Firmware Version: V931212 Parameterisation ID: Type Designation: ZMXi310CQUOLOD3.21 54
Communication Settings: loaded ”\'; 0 ”1_} 0 |

© Landis+Gyr
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5.1.10 Reading device descriptions from a device

Device descriptions can be read from supported Landis+Gyr devices via the avail-
able communication channels of these devices. Please note that always a new
device description is created when reading from a device. It is not possible to
overwrite the currently open device description.

Procedure:

1. Prepare the communication as described in section 6.2 "Communication
settings".

2. Clickon EI in the application toolbar or select Load from device from the
Communication menu.
The connection to the selected device is established via the selected commu-
nication channel and the device description is read from the device into a
new device description window. The device identification and the firmware
version are displayed in the title bar. During the readout process, which can
take several minutes depending on the number of items to be read, a rotat-
ing display is shown in the device description window.

 L6Z1030739188850 (Va31010)* =5
S ©
o0 i
. '. ¢ . » =
. ® .
a F

Connection Time: 40 s

After completing the readout the device description is displayed.
™ L6Z1030739188850 (V931010)* === =
¥ ARk & p
M . 10000: Device Settings

7 10000: Device Settings
= 10007: Configuration
= 10140 Network
= 10056: Terminals
=7 10002: Clock
=7 10031: Energy Registers
7 10059: Demand Registers
= 10250: Tariffication
=7 10147: Time Of Use (TOU)
=7 10142: Billing Data
© 7 10144: Load Profile 1
©  10143: Load Profile 2

w

© 20002: MAP

Device Description ID:  LGZ1030739188859 Firmware Version: V931010 Parameterisation ID:  LGW1040s Type Designation:  ZMXi320CQ

3. Perform the intended work with the device description: You can edit the
parameters of the device description (see section 5.2 "Editing parameters"),
save it (see section 5.1.3 "Saving device descriptions") or write it into a de-
vice (see section 5.3.1 "Parameterisation wizard").
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5.1.11 Comparing a device description to a file

This function allows you to compare the displayed device description with a
device description saved in a file.

The compare page setup can be defined as described in section 5.1.6 "Defining
the print layout for compare results".

Procedure:

1.

Display the device description which you intend to compare with an other
device description saved in a file (proceed as described in section 5.1.2
"Opening existing device descriptions") or in section 5.1.10 "Reading device
descriptions from a device").

Select Compare to file from the View menu.

The "Open" window appears (this is an operating system dialog window and
therefore the dialog language depends on the version of your Windows user
interface).

# Open Device Description X

&« v <« V41 » ZeroSeries » Device configuration » E35C module » Standard 0 series config » v O Search Standard 0 series config @
Organize » MNew folder = | o
&/ Documents A Name - Date modified Type Size

I Desitop ol AT File folder
@ E450 Steiermark @ | Device Description (E360A01)xml XML Document 420
o DC2so & Device Description (E360B01).xml XML Document 473
@) E360LTE @ | Device Description (V541117).xml XML Document 2'63
@ Documentation @ | Device Description (V931010).xml XML Document 2'88
&) TimeOfUsexml XML Document 8
&) FlexModule
&) E35C 26836 Vax
@) LTE NB1 & W1 Trials 2018
@ E450 Vader
@ Quality issue 2019
&) Tenders
&) Temp
4 Downloads
| Pictures v € >
File name: ~| | Device Description files (arml) ~
3. Select your personal data folder in the displayed tree structure if it is not
already displayed.
4. Double-click on the desired entry in the list or select it and then click on

Open.
The displayed device description will be compared with the selected device
description and compare result displayed in the "Compare Preview" window.

The parameter designations are listed in the left column, the parameter values
of the displayed device description in the centre column and the parameter
values of the device description from the file in the right column. Differing
parameter values are highlighted with the defined colour (see section 7.3
"Defining colours").

© Landis+Gyr
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& Compare Preview - [LGZ1

0% BEQDEA

|Type text to find.. 4T |

AT & 525 - Crrgans LU 30 18RS (VST e smeription (Va3 101 Ujarst
Iratan Lol N msrater |u-un Indan Lodial N Imster g 1
Aertus o etz
HIEZE Lo el | IOUEE | Loc cale
B OOUTE | e B POOUTZ Lo B
10152: Idanbification Humssrs
1 01 Ml Se Numter) [(-2:98 1 5)
autmase £
uiBas rSH
TsanETE
i 10 & (105 Carttieste Mt e 18 D
751 Parsmsdsmon 10 (100 2. 1)
ettt 123 Limari LG
10104: Communization Inferfacss
40177 bervioe Communisetion
0708 Cprte ket (022 0.0)
i = e
1m [ tavin
E u =
10173 Looal Communioation
AP Wi M-osn Iritictac (0-01224 6.0}
L B 2450 £
10324: Consumer Informetion Intarfacse
N Gyl bt §5-1 22004
L] a0 e
1 e i
e 2450 e
1 s tan
AT e Ly =
T

Al

See section 5.1.8 "Previewing the printout on the screen" for a description of

the handling features in the "Compare Preview" window.
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Editing parameters

A parameter can be edited in the detail view of the device description window after
selecting the parameter or folder containing the parameter in the tree view of the
device description window (see section 4.4 "Device description window").

Depending on the parameter type, parameters can be modified in different
manners:

e Entering parameter values in entry boxes (see section 5.2.1)

e Selecting parameter values in drop down lists (see section 5.2.2)

e Selecting option parameters (see section 5.2.3)

e Activating or deactivating checkboxes (see section 5.2.4)

e Defining lists by selecting objects (see section 5.2.5)

e Using special functions (e.g. importing time of use tables) (see section 5.2.6)

The corresponding procedures and special features are explained in the indicated
sections with some examples. Specific instructions are contained in the functional
descriptions of the supported devices.

5.2.1 Entering parameter values

Landis+Gyr

Certain parameter values can be entered in entry boxes, in the following example
the deviation of local time to UTC and the maximum time shift without registra-
tion of a clock adjustment event.

General Clock Configuration (0-0:1.0.0)

Time Base (1) internal crystal ~ |

Deviation of Local Time to UTC 120 min 0

Clock Synchronisation (1-0:0.9.11)

Synchronisation Leck O min -~ |

Maximum Time Shift without Registration
of a Clock Adjusted Event g s

The unit of the value is indicated behind the entry box.

The allowed entry range is indicated with a tooltip if the mouse pointer is posi-
tioned on the entry box (in the example shown the value must be in a range from
2 to 255 s).

Clock Synchronisation (1-0:0.9.11)

Synchronisation Lock Omin ~ |

Maximum Time Shift without Registration
of a Clock Adjusted Event s s

N
| 2.255 |
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If an L1 ] icon is displayed behind the entry box, you can position the mouse
pointer over this icon to display a tooltip with information (more complex instruc-
tions and examples) about the entry box, e.g. about the deviation between local

time and UTC:
General Clock Configuration (0-0:1.0.0)

Time Base [{l} internal crystal ~

Deviation of Local Time to UTC  -60 min

-720..720, 30 min steps

Clock Synchronisation (1-0:0.8.11) Western Europe: 0 min
Central Europe: -60 min

Synchronisation Lock Eastern Europe: -120 min

The entries made will be validated against the allowed values. If a value exceeds
the allowed range this is indicated with a red blinking frame around the entry box
with red background and a red frame around the area.

Clock Synchronisation (1-0:0.9.11) g

Synchronisation Lock 0 min *
Maximum Time Shift without Registration
of a Clock Adjusted Event 5

If you position the mouse pointer over the error icon &, a tooltip with infor-
mation about the error is displayed:

Clock Synchronisation (1-0:0.9.11) g

A Enter an integer number between 2 and 255!

Maximum Time Shift without Registration

of a Clock Adjusted Event 1 =
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5.2.2 Selecting parameter values

Certain parameter values can't be entered in entry boxes but must be selected
from a given number of possibilities, in the following example the synchronisation
look time can only be set to one of the five values presented in the drop down list.

Clock Synchronisation (1-0:0.9.11)

Synchronisation Lock 0 min *
Maximum Time Shift without Registration | 0 min
of a Clock Adjusted Event 15 min
30 min
1 hour
1 day

Not only values but also features can be selected in drop down lists.
Digital Input (0-0:199.3.0)
Input Functionality | (2) pulse counter *

(0) disabled

(1) alarm input

(2) pulse counter

(3) external disconnector button

(4) rate control input

5.2.3  Selecting option parameters

Certain parameters can be set by selecting one of the indicated options, in the
following example the date and time reset.

Billing Period Reset (0-0:15.0.0)

Reset Date and Time

() undefined Day

® monthly 1 -

L weekly Hour Minute
) daily oo~ | 00

() daylight saving time begin and end

Changing the selection can have an immediate influence on other parameters or
parameter attributes. In the above example the fields on the right side disappear
for instance if "undefined" is selected.
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5.2.4 Activating or deactivating checkboxes

Certain parameters can be set by selecting several of the indicated options, in the
following example the standard event trigger sources.

Standard Event Log Trigger Sources (0-0:96.11.0)
v X

enabled Event Event MName

1 Power down

2 Fower up

E Daylight saving time enabled or disabled
4 Clock adjusted (old date/time)
5 Clock adjusted (new date/time)
B Clock invalid

g TOU activated

10 Error register cleared

11 Alarm register cleared

12 Program memaony error

13 RAM errar

14 NV memory error

15 Watchdog occurred

16 Measurement system error

Clicking on a checkbox toggles between activated (tick set) and deactivated (tick
removed).

Clicking on the ¥ icon activates all checkboxes.

Clicking on the # icon deactivates all checkboxes.

Activating or deactivating a checkbox can have an immediate influence on the
parameter display. In the following example the maximum demand register para-
meters are only displayed with activated checkbox.

Maximum Demand Register 1 (1-0:1.6.0)
Monitored Value | Current average demand +A (Ql-QIV)

Rate Mumber 0 = rate controlled

With deactivated checkbox the parameters are not visible.

[[] Maxirmum Demand Register 1 (0-0:127.0.101)
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5.2.5 Defining lists by selecting objects

Billing Data Profile (0-0:95.1.0)
Compact Read

Enable Capturing

[] Access Time Window

Captured Object List

Certain parameters (e.g. profiles, display lists, service lists etc.) can be set by copy-
ing a number of objects from a choice list into a captured object list and defining

the order of the selected list entries.

O

Choice: Captured Object List:

- - A ¥
oo e RE9T Group ot mden
1-0:82.80; 2 Pulse counter Energy Total 1 "} 0-0:1.000; 2
1-0:16.8.0; 2 Active energy A (Ol+QIV-QII-CIIT) Energy Total 2 1-0:1.81; 2
1-0:15.80; 2 Active energy A (Ql+QI+QII+QIV) Energy Total 3 1-0:1.8.2: 2
1-0:2.8.0; 2 Active energy export -A (QIl+=QllI) Energy Total 4 1-0:2.8.1; 2
1-0:22.80; 2 Active energy export -A (Qll+QIIT) L1 Energy Total 5 1-0:2.8.2; 2

1-0:42.80; 2 Active energy export -A (CQHI+QIIT) L2 Energy Total

1-0:62.80; 2 Active energy export -A (QI+QIN L2 Energy Total
1-0:1.8.0: 2 Active energy import +4A (Ql+QIV) Energy Total
1-0:21.80; 2 Active energy import +4 (CQl+QIV) L1 Energy Total
1-0:41.80; 2 Active energy import +4 (Ql+QIV) L2 Energy Total
1-0:61.8.0; 2 Active energy import +A (Ql+QIV) L3 Energy Total

Reactive energy export -R (QIll+QIV) Energy Total
1-0:3.80: 2 Reactive energy import +R (QI+QII) Energy Total
1-0:5.8.0; 2 Reactive energy +Ri (O} Energy Total

Active energy import +4 (Q1+CQIV) rate 1
Active energy impart +4 (Q1+QIV) rate 2
Active energy export -A (QII+QII) rate 1
Active energy export -A (Ql1+QIll) rate 2

Clicking on moves the selected entry of the choice list to the captured
object list (to the first position if no entry is currently selected in the list or other-

wise underneath the selected entry in the list).

Clicking on moves the selected entry of the captured object list back to the

choice list (to the original predefined position).

Clicking on | ¥ | or | b | moves the selected entry of the captured object list

one position up or down.

© Landis+Gyr
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5.2.6  Using special functions

Certain parameters can be set using special functions, in the following example

the definition of time of use tables.
Time Of Use (0-0:13.0.0)
=] [+ 2
Active TOU | Passive TOU | Special Days | Emergency Settings
TOUID |ACTIVE

Season Table

"

r‘. e

Season Name  Month Day Week Name

1 1 January 1 1
2 2 April 1 2
3 3 Movember 1 3
Week Table

r:. E

Week Name Mon Tue Wed Thu Fri 5Sat Sun

2 2 1 3 3 3 3 3 3

3 3 1 1 1 11 2 2
Day Tables

Day IT |1 < | DaylD |2 Day ID |3

r:' =S|
Start Time  Action
1 00:00 execute rate script 1+
2 08:00 execute rate script 2~

The special functions (import, save, copy, paste, add, remove etc.) can be selected
by clicking on the corresponding icons (their function is indicated in a tooltip if the

mouse pointer is positioned on the icon).

Specific instructions for the use of these functions are contained in the functional

descriptions of the supported devices.
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5.2.7 Invalid parameter settings

Invalid parameter settings are indicated with an erroricon % and a red frame
around the invalid area in the detail view. Additionally, an error icon @& is dis-
played in the tree item with the invalid parameter and in all hierarchical higher
folders.

47 MAP120 - [Device Description (V931212)*]

™ File View Communication Tools Windows Help .
Ol H G &S @&2 e " Client: [0] Public Access, no authentication * & @& Phone - ]
Device: Default Device = [ IEC:HDLC |-: 10005 | 4 Channel: CommunicationChannel - &
Y Q& k J
W o 20000: Landis+Gyr E450 ~

- Time Of Use (0-0:13.0.0) &9

« @ 10000: Device Settings

5 T 10001 Configuration !:'J '_.} —= »
5 = 10140: Network Active TOU % Passive TOU | Special Days | Emergency Settings
> &5 10056: Terminals TOUID |ACTIVE Day ID 3 not found in any day table
% = 7 10002: Clock
% 77 10031: Energy Registers Season Table
» = 10059: Demand Registers ':" EE] 6
» [ 10250: Tariffication Season Name Month Day Week Name
« & 10141 Time Of Use (TOU) ] ] January 1 ]
@ -;-;’J 10239: Time Of Use 2 2 April 1 2
w 10142 Billing Data 3 3 November 1 3
10066: Billing Period Reset
10240: Billing Period Reset Lockout Time Week Table
10088: Billing Data Profile r:., ES (:3.
» [ 10144: Load Profile 1 Week Name Mon Tue Wed Thu Fri Sat Sun
w  10143: Load Profile 2 19 ’ 1 ’ 1 1 13 3
10238: Load Profile 2 Scheduler 29 3 1 3 3 3 03 3 23
10094: Load Profile 2 3 z : : : T on o2 =
» = 10481 Event Logs
% = 10322: Fraud Detection and Access Supervision Day Tables
» 0 10147: Quality Of Supply
% 7 10148: Disconnector —
» = 10104: Demand And Current Supervision Day ID |1 Day ID |2 ht
5 = 10269: Alarms
3 == 10098: Display s . —= L
5 = 7 10152: Identification Numbers Start Time | Action
% = 10105: Communication Interfaces 1 00:00 no action ’
% = 10285: Push
Device Description ID: Firmware Version: ¥931212 Parametenisation |D: Type Designation:  ZMXi310CQUOLOD3.21 54
Communication Settings: loaded ||\|; 0 ”1} 0 |
The reason for the error (in the above example a missing day table) can be indi-
cated with a tooltip if the mouse pointer is positioned on the error icon.
Please note, that only an error icon is displayed in the tree but not the cause of
the error.
@ Possibility of consecutive errors

The error indicated in the tree can also be a consecutive error whose reason is
another modified parameter.
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5.2.8 Local warnings

Parameter settings which affect a function — but are not invalid — are identified
with a local warning indicated in the detail view but not in the tree. Such para-
meter settings are admissible (i.e. they may be intended) and do not need to be
corrected.

The local warning is indicated with a warning icon . (e.g. in lists) or with an
orange frame (e.g. around entry boxes).

In the example below the warning icons indicate, that the corresponding registers
are inactive (because the energy registers 13 to 16 have been disabled). By posi-
tioning the mouse pointer on the warning icon the cause of the warning is dis-
played as tooltip.

Energy Register Activation (0-0:14.0.1) &

Passive register activation linked to TOU

Choice: Register List: Register Activation: Passive Register Activation:

+* X T

u u

Logical Name Register Logical Name Register g E 'd:_r E E g

0-0-C.8.7 Operating time rate 7 1 1-0:1.8.1 Active energy import +4& (Ql+QIV) rate 1 [ OO0 O O

0-0:C.8.8 Operating time rate 8 2 1-0:1.8.2 Active energy import +4 (Ql+QIV) rate 2 Ol OO (|

0-0:C.8.9 Operating time rate & 3 1-0:1.8.3 Active energy import +£& (Ql+QIV) rate 3 o0 O | [

4 1-0:1.84 Active energy import +A (Ql+QIV) rate 4 O1oOgg O

5 4 0-0:12705  Inactive object O Oodd |

6 | & 197N A Inactive object Ol O O [

7 | & EEiE s Inactive object Ojda O [l ]

8 A 0-0:12708  Inactive object O oOog O

9 1-0:3.8.1 Reactive energy import +R (Ql+Qll) rate 1 [ OO0 O O

10 1-0:3.8.2 Reactive energy import +R (Ql+Qll) rate 2 [N N O [

1 1-0:3.8.3 Reactive energy import +R (Ql+Qll) rate 3 o0 O | O

12 1-0:3.84 Reactive energy import +R (Ql+Qll) rate 4 O1gag [

In the following example the orange frame around the entry box "Threshold" indi-
cates that the supervision has been switched off by entering the value "0".

Supervision Settings /1

Threshold 0 W
Minimum Cwver Threshold Duration | 180 3
Action Up local disconnect N
Minimum Under Threshold Duration | 180 3
Action Down local connect -

By positioning the mouse pointer on the on the warning icon or the entry box with
the orange frame the cause of the warning is displayed as tooltip.

Supervision Settings 1

Threshold If the threshold is set to 0 no actions will be triggered because the threshold

is exceeded all the time and it's impossible to go below it

Minimum Cver Threshold D

Action Up local disconnect *
Minirmum Under Threshold Duration 180 5
Action Down local connect =
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5.3

5.3.1

Landis+Gyr

Device description functions

Sending device description or parameter group to a device

Parameterisation wizard

The parameterisation wizard is used to write a complete device description or a
selected parameter group to a device in a secure manner to guarantee that
devices are parameterised consistently. Therefore the wizard always checks the
necessary access rights before writing any parameter. Only changed parameters
are written to the device.

The following parameter groups can be selected in the parameterisation wizard:
e All parameters including TOU but without security system

e TOUonly

e Security system only (access rights, security definitions, passwords)

For the parameterisation of devices with all parameters except the security sys-
tem the parameterisation wizard permits the input of individual parameter values,
such as device and parameterisation identification numbers for convenient para-
meterisation of several devices with the same parameters. The identification
numbers entered are written to the device instead of the corresponding values
from the device description. Furthermore the device clock can be set to PC time or
to PC time plus an offset in the range of £12 hours.

The parameterisation wizard also allows actions to be performed after para-
meterisation, e.g. resetting registers and profiles.

The starting of the parameterisation wizard and its various parameterisation
possibilities are described in the following sub-sections.

Note: The available functions — especially the security system settings — differ
depending on the device type.
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5.3.2  Starting the parameterisation wizard

The precondition for selecting the parameterisation wizard is that a device descrip-
tion is displayed in the .MAP120, either read out from a device, opened as file or
newly created and edited.

Procedure:

Click on in the application toolbar or select Send to device from the
Communication menu.

The window "Step 1: Selection of parameter group" of the parameterisation
wizard appears, communication is started and the data is read from the con-
nected device.

The firmware version, the configuration ID and the parameterisation ID of the
device description (column "Tree") and the device connected (column "Device")
are displayed in the "Device Information" area, e.g. for a connected E450
ZMX310G meter:

& Parameterisation Wizard X

Step 1@ Selection of parameter group

Dievice Information

Tree Device
Madel ID Va31010 V931010
Configuration M1AD33130D013ns M1AD3313GD0O13ns
Parameterisation 1D LGW1040s LGW1040s
Lagical Device Name LGZ1030739188859

Parameter Group
(@ All parameters except security system
) TOU only

() Security system only (access rights, security definitions, passwords)

| Mext = | | Cancel |

In the "Parameter Group" area the required parameter group can be selected if
the indicated conditions are fulfilled:

e All parameters except security system
can only be selected if the firmware and the configuration ID of tree and
device correspond.

e TOU only
can only be selected if the tree and the device have a time switch according to
the configuration and both belong to the same device series.

e Security System only
can only be selected if the firmware of tree and device correspond and
the necessary security level has been selected. Please contact your local
Landis+Gyr representative to get more information.
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5.3.3  Parameterising all parameters except security system

Procedure:

1. Start the parameterisation wizard (see section 5.3.2 "Starting the parameter-

isation wizard").
2. Select the parameter group option "All parameters except security system".

3. Click on Next >.
The window "Step 2: Selection of ID numbers and clock handling" appears.
The device identification numbers and the clock data are displayed. Please
note that the display is depending on the device connected, i.e. the number
of available IDs can be different.

4, Select the IDs which are to be modified and enter the desired values in the
input boxes of the "Tree" column.

Please note that the entered values are only used for the parameterisation of

the device but are not stored in the device description displayed in the
.MAP120. Only the selected IDs will be written to the device (an empty entry
box deletes the corresponding value in the device).

5. Select the desired device clock handling option (the date and time, the DST
bit and the clock invalid bit of the device clock status are shown):

— Do not change clock
— Set clock to PC time

— Set clock to PC time plus offset (possible range: + 12 hours)

& Parameterisation Wizard X

Step 2: Selection of ID numbers and cleck handling

Device IDs
Tree Device
[ Device ID 2 39188859
Device ID' 3
[] Device ID 4
[] Device ID 5
[] Device ID & Device:ID-6 Device-ID6
Device Clock
@ Do not change clock 03.09.2018 - 14:5%:19 DST on Clock valid

O Set clock to PC time

) Set clock to PC time plus offset 0 h

| MNext > | | Caneel |

6. Click on Next >.
The window "Step 3: Performing parameterisation" appears. In order to
guarantee that the device is parameterised consistently the wizard checks
the necessary access rights, reads the data from the device and compares
the data before writing the changed parameters to the device. The progress

© Landis+Gyr
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of the parameterisation is indicated with a progress bar and a green tick is
set for every action executed successfully. At the end the currently active
communication channel will be closed.

-& Parameterization Wizard

Step 3! Performing parameterisation

Checking security...

Reading data from device...
Comparing tree and device data..
Writing parameterisation to device...

Activating parameters..,

Cancel

7. Click on Next >.

The window "Step 3: Actions after parameterisation" appears.

'ﬁ’ Parameterisation Wizard

Step 4 Actions after parameterisation

Reset Registers
[ All registers
[ Energy total registers
[ Energy tariff registers
[] Demand registers
[[] Cperating time registers
[ Average diagnostic registers
[] M-Bus registers

Reset Alarm / Error

[] Reset Alarm / Errar

Reset Logs

[1 Al event logs

[ Event lags
[] M-Bus event logs

Reset Profiles
[ Al profiles
[] Meter profiles
[] M-Bus profiles
Reset All

[] Complete reset

Caneel
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8. Select the desired resetting actions.

The possible selection is determined by the configuration of the device and is

related to the capabilities of the device.

9. Click on Next >.
If at least one action was selected, the communication with the device is
established, the access rights for the selected actions are checked and the
actions are performed if possible. At the end the currently active commu-
nication channel will be closed and the end window is displayed.

Q Parameterisation Wizard

\_) Parameterisation successfully completed!

| Mext Device || Einish |

10. Click on Next Device if another device shall be parameterised or click on
Finish to terminate parameterisation.
The parameterisation wizard is restarted or terminated depending on the
button clicked.

© Landis+Gyr
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5.3.4 Parameterising time of use

1. Start the parameterisation wizard (see section 5.3.2 "Starting the parameter-
isation wizard").

2. Select the parameter group option "TOU only".

3. Click on Next >.
The window "Step 2: Selection of time of use data" appears.

4. Select the time of use data to be written to the device (either complete time
of use or only individual parts).

Q‘ Parameterisation Wizard

Step 2! Selection of time of use data

TOU

[ Complete TOU Tree Device
[] Active TOU 0200_00 0200_00
Passive TOU CQUART1

Activation date 01.01.2020 undefined
Special days table
[] Emergency settings

| Mext = | | Cancel |

5. Click on Next >.
The window "Step 3: Performing parameterisation" appears and the para-
meterisation is performed (see point 6 to 10 in section 5.3.3 "Parameterising
all parameters except security system").
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5.3.5 Parameterising device security system

1.

Start the parameterisation wizard (see section 5.3.2 "Starting the parameter-
isation wizard").

Select the parameter group option "Security System Only".

Click on Next >.
The window "Step 2: Selection of security system data" appears.

Select the settings which shall apply to all levels:

— Access Level Definitions (Access and Message Security Settings)
— Access Rights

— Changeability of Access Rights

In the "Password (Secret) and Settings per Level" area select one tab after
the other and where required activate the checkboxes "Access and Message
Security Settings" and "Access Rights" if not already set for all levels.

Please note that the number of displayed level tabs is dependent from the
connected device.

Activate the checkbox "Password (secret)" if the password of the correspond-
ing level shall to be modified and enter the desired values in the "Enter New

Password (Secret)" window, which appears after clicking on the Edit icon
in front of the corresponding password entry box.

Please note that the entered values are only used for the parameterisation of
the device but are not stored in the device description. Only the selected
passwords will be written to the device.

-'Q’ Parameterisation Wizard

Step 2! Selection of security system data

All Levels

Access Level Definitions (Access and Message Security Settings)
[] Access Rights

Changeability of Access Rights

Password (Secret) and Settings per Level
Level 0 | Level1 | Lewvel2 | Level3 | Level 9 | Level G | Level L
| Access and Message Security Settings [] Access Rights

Password (secret) |

rrzEzEEEEE K (1) low level authentication using a static password

| Mext = | | Cancel |

Click on x behind the password field, if you want to delete again an entered
password.

© Landis+Gyr
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7. Click on Next >.
The window "Step 3: Performing parameterisation" appears and the para-
meterisation is performed (see point 6 to 10 in section 5.3.3 "Parameterising
all parameters except security system").
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6 Communication with devices

This section describes all aspects of communication with devices, in particular the
communication settings in the Landis+Gyr .MAP120 Parameter Editor for various
applications.

6.1 Basic principle

The communication between the Landis+Gyr .MAP120 Parameter Editor and a
device via a communication channel is strictly client/server based. The client is
part of the .MAP120 Parameter Editor, the server is located in the end device
(e.g. the meter).

Device (Server)
* device series
* logical device
* physical device address
* security material

The required settings in the Landis+Gyr .MAP120 Parameter Editor comprise the
following three main areas:

e Communication channel
e Device (Server)

e Access level (Client)

6.1.1 Communication channel

The communication connection from the Landis+Gyr .MAP120 Parameter Editor
to one or more devices can be made in various ways:

e With a serial connection to a device.

— With an optical reading head placed at the optical interface of the device
(only point-to-point connection to a device possible).

— With a Bluetooth reading head (radio transmission over short distances,
only point-to-point connection to a device possible).

— With a direct connection to a device, e.g. via an R$232, M-Bus, CS or net-
work interface as used in various communication units. If the communica-
tion unit has a second interface (e.g. RS485), multiple connections are
possible to further devices.
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e With a modem connection to a device or several devices, if these are con-
nected together by a multiple connection by R$485, CS or M-Bus. Note: the
modem must first have been installed and configured on the PC.

e With a network connection over a network interface or the Internet to one or
several devices, if these are connected together by a multiple connection by
RS485, CS or M-Bus.

In addition to the physical communication channel also various other settings are
stored here, e.g. used protocol variants, transmission rates, delays, timeouts, etc.

6.1.2 Device

In this area, optional device-specific data can be specified. This mainly includes
the device type or the device series as well as some address information to
address the device (server) via a multiple connection.

6.1.3  Access level

An access level defines all settings required on the Landis+Gyr .MAP side (client).

This includes in particular the identification of the client as well as the algorithms
used for the access and message security. If desired, the necessary keys and pass-
words can also be stored.

D000043592 en n —.MAP120 — Parameter Editor — User Manual Landis+Gyr



60/132

Communication with devices

6.2 Communication settings

All communication settings can be defined and modified in the "Communication
Settings" window.

N

Click on in the application toolbar or select Communication settings from the
Communication menu.

The "Communication Settings" window appears with selected "Connections" tab.

# Communication Settings

Connections | Address Book

Devices + X _" o Communication Channels + e
Device Name  Device Series Channel Name Interface

AD-FE11G150 |E35C - AD-=xE Default Channel COM1

Modem Conexant USB CX93010 ACF Modem
L-L1 E360 - D/F/M-L1 TCP-IP Realtek PCle GBE Family Controller - 192.168.1.20
ZMDA0ZCT E650/5650 - ZxD300/400 USE - Optical Head - 9600 |COMS5

ZMX310P E450 - ZxX100/300P

ZMXi300Q E450 - ZxX100/300Q

Links e
Communication Channel  Remote Address IEC Address HDLC Address Network 1D Network Address
Default Channel ] undefined |[] undefined ] undefined [ undefined
Modem Test Meter [ undefined  |[[]| undefined ]| undefined || undefined
TCP-IP Ethernet Module |[ ]| undefined  |[[] undefined [ undefined |[[]| undefined
USE - Optical Head - 9600 [1lundefined |[] undefined ] undefined |[]| undefined
Data Version: 15 Storage Policy: permanent File Location:  C\Users\user\AppData\l ocal\landis+Gyr\dMAP e

The "Communication Settings" window is subdivided into the following areas:
e List of devices (1) with their names and the associated device series.

— The list can be sorted by any column in ascending or descending order, by
default the devices are displayed in ascending order by name.

— The currently selected device is highlighted and the selection is not
changed by a new sorting.

e List of communication channels (2) with their names and the associated inter-
face, e.g. COM port, modem or network card.

— The list can be sorted by any column in ascending or descending order, by
default the communication channels are displayed in ascending order by
name.

— The currently selected communication channel is highlighted and the
selection is not changed by a new sorting.

e List of links (3) between devices and communication channels with the possi-
ble additional information, particularly with addresses and phone numbers.
The items displayed depend on the selected device or communications
channel (see also section 6.2.5 "Links between devices and communication
channels").

e Status bar (4), in which the currently used version of the communication data
and their location (see section 7.5 "Defining storage location of communica-
tion settings") can be seen as well as the current storage policy of passwords
and keys (see section 7.6 "Defining storage policy for keys and passwords").
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6.2.1

In the following figure a device (highlighted blue) is selected in the list of devices.
All the communication channels not linked are greyed out in the list of communi-
cation channels and the links with their attributes are shown in the list of links.

# Communication Settings

Connections | Address Book

Devices + X , o

Device Series

Communication Channels +

Channel Name Interface

Device Name
AD-FE11G150 |E35C - AD-<E

Default Device |undefined

D-L1 E360 - D/F/M-L1
ZMD402CT E650/5650 - ZxD300/400
ZIMX310P E450 - ZxX100/300P

ZMXB00Q  E450 - ZxX100/300Q

TCP-IP Realtek PCle GBE Family Controller - 192.168.1.20

USB - Optical Head - 9600 |COMS3

Links
Communication Channel

TCP-IP
* | USB - Optical Head - 9600

IEC Adldress HDLC Address Network ID Network Address
defined D defined l:l defined l:l defined
9859 | undefined (]| undefined

Remote Address
Distribution West O
39188859

File Location: ~ CAUsers\user\AppData\l acal\landis+GyridMAP

Data Version: 15 Storage Policy: permanent

In the figure below a communication channel (highlighted blue) is selected in the
list of communication channels. All the devices not linked are greyed out in the list
of devices and the links with their attributes are shown in the list of links.

# Communication Settings

Connections | Address Book

Devices + Communication Channels + x , #ﬂ
Device Name  Device Series Channel Name Interface
Default Channe COM1

AD-FE11G150 |E35C - AD-xE

Default Device |undefined Modem Conexant USB CX93010 ACF Modem

TCP-IP Realtek PCle GBE Family Controller - 192.168.1.20

USB - Optical Head - 9600 |COMS3

ZMXi300Q E450 - ZxX100/300Q
Links
Device Remote Address IEC Acldress HDLC Adldress Network ID Network Address
* AD-FE11G150 | Ethernet Module [/ undefined |[]|undefined [ ] undefined [] undefined

| undefined [ undefined

[J| undefined || undefined
[ undefined |[]| undefined

| undefined  |[[]| undefined

Default Device | Ethernet Module
ZMXi3000Q Distribution West

File Location: ~ CAUsers\user\AppData\l acal\landis+GyridMAP

Data Version: 15 Storage Policy: permanent

Recommended input sequence

Landis+Gyr recommends to define the required data in the following sequence:
1. Communication channels (see section 6.2.2 "Communication channel data")
Devices including the corresponding access data (see section 6.2.3 "Device data")

2
3. Addresses (see section 6.2.4 "Address data")
4

Links between devices and communication channels including the relevant
attributes (see section 6.2.5 "Links between devices and communication

channels"
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6.2.2 Communication channel data

After the installation of the .MAP120 Parameter Editor only a default device
named "Default Device" and a default communication channel named "Default
Channel" are defined. These default communication settings are the basis for a
local readout of a meter with an optical reading head connected to the serial
interface. At least the serial interface (COM port) has to be adapted in most cases.

The following basic procedure should be adopted to create and store a new
communication channel definition (specific examples are given in section 6.5
"Communication examples"):

1. Click on in the application toolbar or select Communication settings
from the Communication menu.
The "Communication Settings" window appears with selected tab "Connec-
tions" (as shown here with the default communication settings or with addi-
tional data, if already defined).

2. Highlight a communication channel in the communication channel list
(default channel or any other communication channel, if already defined).

&' Communication Settings

Connections | Address Book
Devices + Communication Channels + X _’
Device Name  Device Series Channel Name  Interface
Default Device |undefined Default Channel COM1
Links
Device Remote Address IEC Address HDLC Address Network 1D Network Address
Default Device [[]| undefined |[] undefined []/ undefined |[] undefined
Data Version: 13 Storage Policy: permanent File Location:  CA\Users\user\AppData\\l ocal\landis+Gyr\dMAP

3. Clickon + in the window toolbar in the "Communication Channels"
area.
The "Communication Channel" window appears. The entry box "Name"
contains the placeholder name "CommunicationChannel", all other fields
contain a copy of the data of the selected communication channel and can
now be modified.
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Communication Channel x

Name |CommunicationChannel

Interface

Interface Type Serial (optical head or 3-wire) "
Physical Interface COM1 “’
Template for Lower Layer Settings select template “ || Apply

Physical Layer | dims Link Layer | dims Application Layer | IEC

Serial Interface

Transmission Speed 300 ~ | bps
Port Settings 8 Bit (8 data bits / no parity) "
[ Idle time after connection 0 ms

4. Enter a name for the new communication channel definition in the entry box

"Name".

5. Select the interface type of the connected device in the "Interface type" drop

down list:

- Serial (optical head or 3-wire)

- Bluetooth optical head (PMR_1)
- Bluetooth optical head (PMR_1A)
- Modem

= Network

6. Select the used interface in the "Physical interface" drop down list:

- an available COM port if "Serial" or "Bluetooth optical head" was selected
as interface type (the COM port number of a serial interface can be found
in the Windows device manager),

- an available modem if "Modem" was selected as interface type or

- an available network adapter if "Network" was selected as interface type.

7. Select the suitable template for the communication channel settings in the

"Template for lower layer settings" drop down list. The following templates
are available (selection possibilities dependent on the selected physical
interface and interface type):

- Serial - IEC
(start protocol IEC with 300 bps)

- Serial - dlms
(dlms/HDLC protocol with 9600 bps)

- M-Bus - dlms
(dlms/HDLC protocol with 9600 bps and 9 Bit transmission)
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- Bluetooth - [EC
(same as "Serial — IEC", but with special control of the Bluetooth reading
head)

- Bluetooth - dims
(same as "Serial — dIms", but with special control of the Bluetooth reading
head)

- PSTN Modem
(dlms/HDLC protocol with extended timeouts of 5 s)

- GSM Modem
(dlms/HDLC protocol with extended timeouts of 10 s)

- Wired - HDLC
(dIms/HDLC protocol via wired network, e.g. Ethernet)

- Wired - Wrapper
(dlms/Wrapper protocol via wired network, e.g. Ethernet)

- Wireless - HDLC
(same as "Wired — HDLC", but with extended timeouts since the
transmission times can be significantly higher e.g. with GPRS)

- Wireless - Wrapper
(same as "Wired — Wrapper", but with extended timeouts since the
transmission times can be significantly higher e.g. with GPRS)

After selection of a template the button "Apply" is activated. If you click on it,
all communication channel settings are set automatically according to the
template.

Now you can directly continue according to subsection 6.2.2.5 "Terminating
the communication channel definition" or check the settings on each tab
according to the following subsections.
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6.2.2.1 Physical Layer

1. Select the "Physical Layer" tab.
Depending on the interface type selected the setting possibilities are
different.

If interface type "Serial" or "Bluetooth optical head" is selected:

Communication Channel x

Name |USE - Optical Head - 9600

Interface

Interface Type Serial (optical head or 3-wirg) "
Physical Interface COM3 ~
Template for Lower Layer Settings select template “ || Apply

Physical Layer | dims Link Layer | dims Application Layer | IEC

Serial Interface

Transmissian Speed 2800 ~ | bps
Port Settings 8 Bit (8 data bits / no parity) "
[ Idle time after connection 0 ms

2. Select the transmission rate corresponding to the device in the "Transmission
speed" drop down list for local communication.

3. Select the required communication port settings in the "Port settings" drop
down list:

- 8 Bit (8 data bits / no parity) (default), to be used normally

- 9 Bit (8 data bits / even parity), to be used if the connection to the serial
interface of the PC is made via an USB M-Bus converter

4. Tick the "Idle time after connection" checkbox if you want to modify the
default initial delay (IEC standard value = 0 ms). Then enter the required
value in the "ldle time after connection" entry box.
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If interface type "Network" is selected:

Communication Channel x

Mame |TCP-IP
Interface

Interface Type
Physical Interface

Template for Lower Layer Settings

Physical Layer | dims Link Layer
Metwork Interface

Protocol

Source Port

[ Idle time after connection

Metwork -
Realtek PCle GBE Family Controller - 192.168.1. ~

select template “ || Apply

dims Application Layer | IEC

TCP ~

2. Select the required communication protocol in the "Protocol" drop down list:

- TCP (Transmission Control Protocol)

- UDP (User Datagram Protocol)

3. Ifrequired enter a source port number (only if IPv6 is used) otherwise do not
change the default setting "0" (automatic selection).

4. Tick the "Idle time after connection" checkbox if you want to modify the
default initial delay (IEC standard value = 0 ms). Then enter the required
value in the "Idle time after connection" entry box.

© Landis+Gyr
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If interface type "Modem" is selected:

Communication Channel x

MName |Maodem

Interface
Interface Type Modem
Physical Interface Conexant USB CX93010 ACF Modem ~

Template for Lower Layer Settings select template

Physical Layer | dims Link Layer | dims Application Layer | IEC

[ Idle time after connection 0 ms

2. Tick the "Idle time after connection" checkbox if you want to modify the
default initial delay (IEC standard value = 0 ms), e.g. with GSM networks.
Then enter the required value in the "ldle time after connection" entry box.
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6.2.2.2

dims Link Layer

1. Select the "dIms Link Layer" tab.
The settings on this tab apply if the dims protocol is used.

2. Select the required protocol for the planned activity in the "dIms Link layer
protocol" drop down list. Possible settings:
- HDLC, if the HDLC protocol must be used

- HDLC via IEC mode E (default), if the IEC protocol must be used for
opening the communication

- COSEM Wrapper, if the COSEM Wrapper over the TCP protocol must be
used

Communication Channel x

Mame |USE - Optical Head - 9600

Interface

Interface Type Serial (optical head or 3-wire) ~
Physical Interface COM3 V
Template for Lower Layer Settings select template “ || Apply

Physical Layer | dlms Link Layer | dims Application Layer | IEC

dlms Link Layer Protocol HDLC via IEC mede E V
IEC Mode E
Transmission Speed Switching 9600 ~ | bps
Intercharacter Timeout 3000 ms
Maximum Mumber of Retries 3 @
HDLC
Maxirmum HDLC Buffer Size 248 bytes
Message Timeout 2000 s
Maximum Mumber of Retries 3 @

3. Depending on the selected link layer protocol, the IEC Mode E, HDLC or
COSEM Wrapper areas are displayed to make the required settings.

In the IEC Mode E area (only displayed if "HDLC via IEC mode E" is selected as
link layer protocol):

- Transmission Speed Switching: Select the required maximum transmission
rate (default = 9600 bps). Untick the checkbox if you don't want to allow
transmission rate switching.

Note: In case of modem or network connections no real change is made
but only the transmission rate character in the protocol is altered.

- Intercharacter Timeout: After expiration of the set time the transmission
is automatically ended if no further data is transmitted. If you untick the
checkbox, no automatic termination of the transmission occurs.

= Maximum Number of Retries: Select the number of retries (default value
= 3). If you select 0, no retries occur.

© Landis+Gyr

D000043592 en n —.MAP120 — Parameter Editor — User Manual



Communication with devices

69/132

In the HDLC area (only displayed if "HDLC" or "HDLC via IEC mode E" is

selected as link layer protocol):

- Maximum HDLC Buffer Size: Tick the checkbox if you want to modify the
default value (128 bytes). The HDLC buffer size determines how many
useful data can be transmitted in one data packet. Reduce the value in
case of communication problems.

- Message Timeout: If you untick the checkbox, no automatic termination
of the transmission occurs.

- Maximum Number of Retries: Select the number of retries (default value
= 3). If you select 0, no retries occur.

In the COSEM Wrapper area (only displayed if "COSEM Wrapper" is selected

as link layer protocol):

- Message Timeout: If you untick the checkbox, no automatic termination
of the transmission occurs.

6.2.2.3 dims Application Layer

1. Select the "dIms Application Layer" tab.

The settings on this tab apply if the dlms protocol is used.

Communication Channel x

MName |USE - Optical Head - 9600

Interface

Interface Type Serial (optical head or 3-wire) ~
Physical Interface COM3 "
Template for Lower Layer Settings select template ~ || Apply

Physical Layer | dlms Link Layer | dims Application Layer | |EC

Referancing Methad Shert Name (SN) referencing o

The command set supported by Ingical name referencing is very limited. Please use short name referencing
unless otherwise instructed.

Maximum Mumber of Elements in Lists 45 @

Single Request Firmware Releases BO&;B09:E10:811:C06:COT:C08:C0%:D41:D42:D43: 0~
[] Maximum dlms Buffer Size 0 bytes

[] Block transfer with set, write and action services supported

Keep alive Interval 30 H

Use releasze service to close Aszzociation Application

2. Select "Short Name (SN) referencing" or "Logical Name (LN) referencing"

method. The command set supported by LN referencing is very limited. The
.MAP tools only work with short names. Therefore SN referencing is the
preferred choice unless otherwise instructed.

3. Tick the "Maximum Number of Elements in Lists" checkbox to activate the

use of lists for read and write operations. Enter the maximum number of
elements in lists. In case of readout problems this value (default = 45) can be
reduced down to 1. It should be noted that this slows down the readout
significantly.
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If required, modify the "Single Request Firmware Releases". This entry box
contains all releases (separated by semicolons), for which automatically
single requests will be used, i.e. no list requests are used.

Tick the "Maximum dims Buffer Size" checkbox if you want to limit the maxi-
mum buffer size in the .MAP tool for writing of data (default value = 0). Then
enter the required value in the "Maximum dims Buffer Size" entry box.
Principally the buffer sizes for writing and reading reported from the device
are used. If a maximum buffer size is determined, this size is not exceeded
during writing, even if the device reports a bigger write buffer size. If you
untick the checkbox, the buffer size is unlimited, i.e. buffer size indicated by
the device is used.

Tick the "Block transfer with set, write and action services supported" check-
box if you want to allow write operations with blocks and if your device also
supports block transfers. The use of blocks for writing depends on the data
guantity, the maximum number of list items and the dlms buffer size. It is
recommended to disable this setting in case of transmission problems.

Keep alive interval: After this time an "Alive-Packet" is to be sent in order to
maintain the connection. The value must be greater than the message time-
out value (default = 30 s). If you untick the checkbox, the function is switched
off.

Tick the "Use release service to close Association Application" checkbox if a
release request shall be sent before closing the HDLC connection (with
COSEM Wrapper a release request is always sent).
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1. Select the "IEC" tab.
The settings on this tab apply for devices that support solely the IEC protocol.

Communication Channel x

Name |USB - Optical Head - 9600

Interface

Interface Type Serial (optical head or 3-wire) "
Physical Interface COMS5 ~
Template for Lower Layer Settings select template “ || Apply

Physical Layer | dlms Link Layer | dims Application Layer | |EC

Transmission Speed Switching 2600 ~ | bps
Intercharacter Timeout 3000 ms
Maximum Number of Retries 3 @
Password far B3/ W5 Commands (static)
Maximum R1/W1 Command Size 16 bytes

2. Select the required maximum transmission rate (default = 9600 bps) in the
"Transmission Speed Switching" drop down list. Untick the checkbox if you
don't want to allow transmission rate switching.

Note: In case of modem or network connections no real change is made but
only the transmission rate character in the protocol is altered.

3. Intercharacter Timeout: After expiration of the set time the transmission is
automatically ended if no further data is transmitted. If you untick the "Inter-
character Timeout" checkbox, no automatic termination of the transmission
occurs.

4. Select the number of retries (default value = 3) in the "Maximum Number of
Retries" entry box. If you select 0, no retries occur.

5. Enter the required static password (8 characters) for R5/W5 commands in the
"Password for R5/W5 Commands" entry box.

6. Enter the maximum length in bytes of the R1/W1 commands in the "Maxi-
mum R1/W1 Command Size" entry box.
This value limits the block size for the transmission of large amounts of data,
e.g. display lists or tables of use. Values greater than 16 bytes are not sup-
ported by all devices. Please refer to the respective device documentation to
find out which values are supported by your device.
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6.2.2.5 Terminating the communication channel definition

1. Click on OK.
The new communication channel definition is saved. A new entry with the
defined name appears in the communication channel list.

# Communication Settings

Connections | Address Book

Devices + Communication Channels + x ." o"’
Device Name  Device Series Channel Name Interface
Default Channel COM1

USB - Optical Head - 9600 COM1

Links

Device Remote Address IEC Address HDLC Address Network 1D MNetwork Address

Data Version: 13 Storage Policy: permanent File Location: ~ Ch\Users\user\AppData\local\landis+GyridMAP

2. Define further required communication channels in the same way.

3. Close the "Communication Settings" window.

@ Modifying or deleting communication channel definitions

If you intend to modify or delete a communication channel definition, mark the
corresponding entry in the communication channel list and then

e clickon f in the window toolbar in the "Communication Channels" area
to modify the marked entry of the communication channel list or double click
on the entry.

e clickon X in the window toolbar in the "Communication Channels"
area to delete the marked entry of the communication channel list (deletions
must be confirmed).
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6.2.3 Device data

After the installation of the .MAP120 Parameter Editor, only a default device
named "Default Device" and a default communication channel named "Default
Channel" are defined. These default communication settings are the basis for a
local readout of a meter with an optical reading head connected to a serial
interface.

Additionally, other device-specific properties can be defined here, if required.

The following basic procedure should be adopted to create and store a new
device definition (specific examples are given in section 6.5 "Communication
examples"):

N
1. Clickon in the application toolbar or select Communication settings
from the Communication menu.
The "Communication Settings" window appears with selected tab "Links".

2. Highlight a device in the device list (any device or other device, if already

defined).
# Communication Settings
Connections | Address Book
Devices + X f Communication Channels +
Device Name  Device Series Channel Name Interface
DefalllDeuicegumleﬁmd Default Channel COMA1
Links
Communication Channel Remote Address |EC Address HDLC Address Network 1D Network Address
Default Channel [/ undefined ]| undefined [[1| undefined |[] undefined
Data Version: 13 Storage Policy: permanent File Location:  C\Users\user\AppData\local\landis+Gyr\dMAP

3. Clickon + in the window toolbar in the "Devices" area.
The "Device" window appears. The entry box "Name" contains the place-
holder name "Device", all other boxes contain the data of the selected device
and can now be modified.
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Name |Device

Type | Address | Clients
Cevice Type
Device Series undefined -
Manufacturer Serial Number

Logical Device Base Meter / Module ~ | 1

The logical device may be overridden by a command in seme cases.

4. Enter a name for the new device definition in the entry box "Name".

6.2.3.1 Type
1. Select the "Type" tab.

MName |ZM)(|'EODQ |

Type | Address | Clients
Device Type
Device Series undefined -
Manufacturer Serial Number
Logical Device Base Meter / Module ~ | 1

The logical device may be overridden by a command in seme cases.

2. Select the device series in the "Device Series" drop down list.

The selected device series has the effect, that the command tree will be
changed accordingly, if the device is selected in the device toolbar. If you
leave "undefined", no adaptation of the command tree occurs.

© Landis+Gyr
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3. Ifrequired, enter the manufacturer serial number with a maximal length of
20 characters and a restricted character set ('0'..'9', 'A'..'Z', 'a'..'z') in the
"Manufacturer Serial Number" entry box.

Please note that this entry has currently no meaning but may be used for
extended device management in the future.

4. Select the device type in the "Logical Device" drop down list: "Base Meter /
Module" (=1) or "Communication Unit" (=17) or "user defined" for devices
from third party suppliers (in this case, you must enter the logical device
number according to the manufacturer information).

Note that this selection is only possible if the device series is set to "unde-
fined". Otherwise it is fix set to "Base Meter / Module" (=1) or "Communica-
tion Unit" (=17), depending on the selected device series. Also note that the
logical device may be overridden by a command in some cases, if the com-
mand is implemented only for a specific logical device (e.g. communication
unit).

6.2.3.2 Address
1. Select the "Address" tab, if a device address shall be used.

2. Set atick to the "IEC address" and/or "HDLC address" checkbox and enter
the address(es).
If you enter an IEC address first and then click on the arrow button behind
the two entry boxes, the HDLC address is automatically calculated and
entered (see section 6.3 "Addressing devices").

Device %

Name |ZMXi300Q
Type | Address | Clients

Physical Device Address

IEC Address 30188859 @
HDLC Address |9839

The use of an [EC and/or HDLC address defined here is controlled by the link seftings.
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6.2.3.3 Access levels

The various access levels and their fields of application are described in section 9
"Short description of device security system".

1. Select the "Clients" tab to define the device-specific access levels.
MName |ZMXi3000
Type | Address | Clients

Device Specific Access Levels

[0] Public Access, no authentication
[3] Utility Service, no authentication

[F] Manufacturer Access, static password

Import all Credentials {OHIine)| |Imp::|rt all Credentials (O nline]|

After the installation of the .MAP120 Parameter Editor no passwords for the dif-
ferent access levels are defined. Therefore only the access levels without pass-
word protection, e.g. "[0] Public Access" or with fix set password as "[F] Manufac-
turer Access" can be used. They are shown in the list of device specific access
levels by default. For all other required access levels the credentials have to be
entered as described below or imported (see section 6.2.3.4 "Importing keys").

2.  Click on Settings.
The "Access Levels" window appears for the specified device.
The device name is displayed in the top left corner.
The window contains a list of all access levels with "Client AP" (User ID, UID),
authentication, additional requisites, message security policy, security setup
and supported protocols that can be used for any device.
An & icon is displayed in the first column as long as the access level is not
correctly defined (e.g. missing or incomplete password). Accordingly marked
access levels will not be shown in the Client toolbar.
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ZMXi300Q
Access Level Client AP Authentication Additional Requisites Message Security Policy Supported Protocols
[0] Public Access 16 no authentication no ciphering |EC and dims

1 [1] Data Collection 32 low level authentication using a static password no ciphering IEC and dims

1 [1] Data Collection 32 high level authentication using SHA-256 no ciphering dlms anly

1 [2] Utility Field Service 42 low level authentication using a static password no ciphering IEC and dims

1 [2] Utility Field Service 48 high level authentication using SHA-1 no ciphering dlms only

1 [2] Utility Field Service 48 high level authentication using GMAC na ciphering dlms anly

1 [2] Utility Field Service 42 high level authentication using SHA-256 no ciphering dims only
[3] Utility Service 64 no authentication service menu required no ciphering IEC and dims

1 [G] Management Access |1 low level authentication using a static password no ciphering dlms only

1 [G] Management Access |1 high level authentication using SHA-1 no ciphering dlms only

1 [G] Management Access |1 high level authentication using GMAC no ciphering dlms anly

1 [G] Management Access |1 high level authentication using SHA-258 no ciphering dlms only

1 [] Security Auditor 5 high level authentication using GMAC no ciphering dlms only

1 [] Calibration Lab 6 high level authentication using GMAC na ciphering dlms anly

1 [] Communication Module |7 high level authentication using GMAC no ciphering dlms only

1 [ Local Cperator 9 high level authentication using GMAC no ciphering dlms only

1 [L] Access Administrator |2 low level authentication using a static password no ciphering dlms only

1 [L] Access Administrator |2 high level authentication using SHA-1 no ciphering dlms only

1 [L] Access Administrator |2 high level authentication using GMAC no ciphering dlms only

1 [L] Access Administrator |2 high level authentication using SHA-256 no ciphering dlms only
[F] Manufacturer Access | 104 low level authentication using a static password | hardware switch required | no ciphering dlms anly
[¥] User Defined 1 0 no authentication na ciphering IEC and dims

3. Specify the access levels to be used by double clicking the corresponding entry

(or by selecting it and clicking on the edit icon f ) and then making the
necessary entries in the appearing "Access level Definition" window.

Depending on the access level to be defined and other inputs, the individual
fields can be modified or are set immutable.

Access Level Definition - ZMXi

[2] Utility Field Service

=)

Client Application Process ID 4 [JUserip |0
Access Security
Authentication low level authentication using a static password

Additional reguisites =

Message Security

Authenticated Encrypted Signed
Credentials
£y
Password [secret) _'

Global Authentication Key (GAK)

Global Unicast Encryption Key (GUEK)
Import Credentials (Offling)

mport Credentials (Online)

Supported protocols IEC and dims

4. Only for user defined access levels: Enter a "Client Application Process ID"

(default is 16).
For all other access levels the "Client Application Process ID" is fix assigned in
a range from 1 to 255 and cannot be changed.

5. Tick the "User ID" checkbox if you want to send additional information about

the user to the device and then enter a user ID in the range from 1 to 255 (0
= don't use a user ID). The device only allows to establish a connection if this
user ID is also enabled there.
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A user ID is currently only supported by a few devices. Please refer to the
respective device documentation to find out whether this is supported by
your device or not (not to be selected as default).

6. Only for user defined access levels: Select the type of authentication in the
"Authentication" drop down list.
The selection is described in section 9.2 "Security attributes" under "Access
authentication"). For all other access levels the authentication is fix assigned
and cannot be changed.

The unchangeable display "Additional requisites" shows information about
specific access levels as "service menu required" or "hardware switch re-
quired".

7. Only for access levels with high level authentication using GMAC and SHA-
256: Tick the "Authenticated" and or "Encrypted" checkboxes for the corre-
sponding message security (for both request and response).

"Signed" is reserved for future use and can therefore not be selected.

8. Only for access levels with low level authentication or with high level

authentication using SHA-1:
"

Click on the edit icon L and then enter the password or key in the appea-
ring "Enter new password (secret)" window either as visible string or hexa-
decimal and then confirm the entry with OK.

Enter new password (secret) x

Static password

(®) visible string |98?65432 | i ]

() hexadecimal characters 8/16

For security reasons, the password (secret) is only visible as you type it in. After
entering a placeholder is shown with asterisks. In case of a future modification,
it must be re-entered.

Access Level Definition - ZMXi3000

[2] Utility Field Service
Client Application Process ID 48 [] UseriD
Access Security
Authentication low level authentication using a static password

Additional reguisites

Message Security

Authenticated Encrypted Signed

Cradentials

Password (secret) Iz‘ srrreennes E‘

Global Authentication Key (GAK)
Global Unicast Encryption Key (GUEK)

tials (Offline) mport Credentials (Online)

Supported protocols IEC and dims
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Click on the x icon behind the password entry box if you want to delete a
previously defined password (secret).

9. Only for access levels with high level authentication: Either import the
required authentication and/or encryption keys (GAK and GUEK) from a
received key file (see section 6.2.3.4 "Importing keys") or

[

"
click on the corresponding edit icon 4 and type in the key in the "Enter
new key" window either as visible string or hexadecimal and then confirm
the entry with OK.

Enter new key x

Global Authentication Key (GAK)

O wisible string Elx‘AQASATA.’)AEAAMSAZMADAA&BAEADAF | o

® hexadecimal characters 30/64

For security reasons, the key is only visible as you type it in. After entering a
placeholder is shown with asterisks. In case of a future modification, it must be
re-entered.

Mccess Level Definition - ZMXi3000

[G] Management Access
Client Application Procass ID 1 |:| UseriD O
Access Security
Authentication high level authentication using GMAC
Additional reguisites =
Message Security
Authenticated Encrypted Signed
Credentials

Password (secret)

Global Authentication Key (GAK) E
Global Unicast Encryption Key (GUEK) srrrasaens E‘

Import Credentials {Offline) |Import Credentials {Online}l|
Supported protacols dlms anly

The fixed display "Supported protocols" shows the supported protocols for
the access level. Possible values are "IEC and dims" and "dIms only".
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10. Click on OK.

The "Access Levels" window appears again.

No % icons are displayed in the first column of the newly defined access
levels.

ZMXi300Q
Access Level Client AP Authentication Additional Requisites Message Security Policy Supported Protocols
[0] Public Access 16 no authentication na ciphering IEC and dims
[1] Data Collection 32 low level authentication using a static password na ciphering IEC and dims
1 [1] Data Collection 32 high level authentication using SHA-256 no ciphering dlms only
[2] Utility Field Service 43 low level authentication using a static passwerd no ciphering IEC and dims
1 [2] Utility Field Service 43 high level authentication using SHA-1 no ciphering dims only
1 [2] Utility Field Service 43 high level authentication using GMAC na ciphering dims only
1 [2] Utility Field Service 43 high level authentication using SHA-236 no ciphering dims only
[3] Utility Service 64 na authentication service menu required | no ciphering IEC and dims
1 [G] Management Access |1 low level authentication using a static password na ciphering dims only
1 [G] Management Access |1 high level authentication using SHA-1 no ciphering dlms only
[G] Management Access |1 high level authentication using GMAC authentication and encryption | dims anly
1 [G] Management Access |1 high level authentication using SHA-256 no ciphering dims only
1 [ Security Auditor 5 high level authentication using GMAC no ciphering dlms only
1 [] Calibration Lab 6 high level authentication using GMAC no ciphering dims only
1 [] Communication Module | 7 high level authentication using GMAC na ciphering dims only
1 [ Local Operatar 9 high level authentication using GMAC no ciphering dims only
[L] Access Administrator 2 low level authentication using a static password na ciphering dlms only
1 [L] Access Administrator |2 high level authentication using SHA-1 na ciphering dims only
1 [L] Access Administrator |2 high level authentication using GMAC no ciphering dlms only
1 [L] Access Administrater |2 high level authentication using SHA-256 no ciphering dims only
[F] Manufacturer Access | 104 low level authentication using a static password | hardware switch required | no ciphering dlms only
[¥] User Defined 1 0 na authentication no ciphering |EC and dims

11. Click on OK.
On the "Clients" tab of the "Device" window the defined device-specific
access levels are displayed.

Mame |ZMXi3000
Type | Address | Clients
Device Specific Access Levels

[0] Public Access, no authentication

[1] Data Collecticn, static password

[2] Utility Field Service, static password

[3] Utility Service, no authentication

[G] Management Access, GMAC authentication
[L] Access Administrator, static password

[F] Manufacturer Access, static password

Import all Credentials {Of‘ﬂine)| |Import all Credentials (Online)

All these fully defined access levels can be selected in the "Client" drop down
list in the client toolbar if the corresponding device is selected in the "Device"
drop down list.
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Eile View Communication Tools Windows Help
O01 B @@ & 9 |97 Client: (0] Public Access, no authentication @ @[ e 3
Device: | ZMXi300Q = e N L0] Public Acce: 0 authentication Head - 9600 .

e ! [ (e [1] Data Collection, static passward 2 o !

[2] Utility Field Service, static password

[3] Utility Service, no authentication

[G] Management Access, static password

[G] Management Access, GMAC authentication
[L] Access Administrater, static password

[F] Manufacturer Access, static password

[c ication Settings: loaded [® o]

12. Continue as described in section 6.2.3.5 "Terminating the device data
definition".
6.2.3.4 Importing keys

If the authentication and/or encryption keys are not available in a legible form,
you can import them from key files (offline) or from a remote key management
system (online).

Offline key import

@ Required key files
The required key files will be supplied to you by your Landis+Gyr representative.

Name |ZMXi300Q |

Type | Address | Clients

Device Specific Access Levels

[0] Public Access, no authentication
[3] Utility Service, no authentication

[F] Manufacturer Access, static password

Import all Credentials (Offline)| [Import all Credentials (Onlinel)

Proceed as follows to import keys from key files:

1. Click on Import all Credentials (Offline).
The "Import Keys" window appears.
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Import

Encryption Keys

File Name |

Device Selection

Key(s) found:

(-]

Utility Key
File Name
Password
2. Clickon in the "Encryption Keys" area.

The "Open" window appears.

3. Select the directory where the encryption key file is stored in the displayed
tree.

4. Select the encryption key file you want to import.

Organize +

NN » AppData » Local » Landis+Gyr » dMAP
MNew folder
~

ComponentOne LLC ~ MName
ConnectedDevicesPlatfo tmp
CrashDumps tmp 101126
CrashRpt = AddressBookV14.xml
D3D5Cache = AddressBookV13xml
DBG “ DeviceConnectionSettingsV14.xml

. . =) DeviceConnectionSettingsV15xml
Diagnostics

ElevatedDiagnosti
svatedbiagnostics GULF_V2.0_Example V7xml

GEFEG :

=] PhoneBookaml
Google =) SecuritySettingsV14xml
GrapeCity,_Inc |2 SecuritySettingsV15.xml

Information Factory = xPhoneBook.xml

v <

el

= GB_51300256_13346-10_LANDIS+ GYR(PL)...

v 0 Search dMAP pel
E~- M @
Date modified Type Size
File folder
File folder

XML Document
XML Document

XML Document

AML Document
AML-Document
XML Document
XML Document
XML Document

XML Decument

XML Document v
>

File name: | GB_51300256_18346-10_LANDIS+GYR{PL)SP.Z.0.0.xml

w | Device Description files (*xml)

Cancel

5. Click on Open.
The keys are imported from the encryption key file and the available device
serial numbers will be listed in the "Device Selection" area.
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Import Keys x

Encryption Keys

File Name | C\Users\user\AppDatatLacalLandis+Gyr\dMAP\GE_51300256_18346-1( E‘

Device Selection

14797082
14797083
14797084
14797085
14797086

Key(s) found:

Utility Key

File Name

Password

O

Click on in the "Utility Key" area.
The "Open" window appears.

Select the directory where the utility key file is stored

Select the utility key file you want to import.
This file is required to decrypt the key file.

in the displayed tree.

« v » AppData » Local » Landis+Gyr » dMAP v | O Search dMAP r
Organize * Mew folder =« [H o
ComponentOne LLC ~ # MName - Date modified Type Size ™
ConnectedDevicesPlatfo tmp 26.11.2 Dateiordner
CrashDumps tmp 101126 26.11.2019 10:49 Dateiordner
CrashRpt D RWE_privkey.pem 07.01.2014 13:00 PEM-Datei
D3D5Cache
DBG
Diagnostics
ElevatedDiagnostics
GEFEG
Google
GrapeCity,_Inc
Infermation Factory o
fm ekl i ¢ >
File name: |RWE_pr|vkey.pem V| Certificates (*.pfe™.pl2:".pem;™ ~
Cancel
9. Click on Open.

The utility key is imported from the key file.
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Import Keys x

Encryption Keys

File Name | CA\Users\user\AppDatatLacalLandis+ Gyr\dMAP\GE_51300256_18346-1( E‘

Device Selection

14797082 Key(s) found:

14797083 Authentication Key A
14797084 Unicast Encryption Key

14797085 - Utility Field Service, static password

14707025 - Utility Field Service, SHA-1 authentication

- Utility Field Service, SHA-256 authentication
Authentication Key O

Utility Key

File Name |C:\Users\user\AppLlatat\LocalLandis+Gyr\dMAPNRWE_privkey.pem

Password oK

10. Click on OK.
The "Import Keys" window disappears and the associated device-specific
access levels are displayed.

Name |ZMXi300Q
Type | Address | Clients
Device Specific Access Levels

[0] Public Access, no authentication

[1] Data Collecticn, static password

[2] Utility Field Service, static password

[3] Utility Service, no authentication

[G] Management Access, GMAC authentication
[L] Access Administrator, static password

[F] Manufacturer Access, static password

Import all Credentials {Of‘ﬂine)| |Import all Credentials (Online]|

Online key import

@ Required prerequisites
Before you can import keys online from a remote key management system the
required credentials must have been entered on tab "Key Management system"
in the "Options" window (see section 7.7 "Defining the key management system").
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Name |ZMXi300Q
Type | Address | Clients
Device Specific Access Levels

[0] Public Access, no authentication

[3] Utility Service, no authentication

[F] Manufacturer Access, static password

Import all Credentials {Ofﬂine)| |Imporl all Credentials (0n|ine]|

Proceed as follows to import keys from a remote key management system:

1. Click on Import all Credentials (Online).
The "Import Keys" window appears.

Import Keys

Import frem remote system

Referenced Key Mangement System: Productive System

v X &

Import Access Level

[1] Data Collection

[2] Utility Field Service
[2] Utility Field Service
[2] Utility Field Service

[G] Management Access

[G] Management Access

<

[G] Management Access
Role: Security Auditar
Raole: Calibration Lab

Role: Communication Module
Role: Local Operator
[L] Access Administrator

[L] Access Administrator

[L] Access Administrator

Client AP Authentication

32
48
48
48

=1 o |

P2 ra | o

high level authentication using SHA-256
high level authentication using SHA-1
high level authentication using GMAC
high level authentication using SHA-256
high level authentication using SHA-1
high level authentication using GMAC
high level authentication using SHA-256
high level authentication using GMAC
high level authentication using GMAC
high level authentication using GMAC
high level authentication using GMAC
high level authentication using SHA-1
high level authentication using GMAC
high level authentication using SHA-256

Status

Request keys from remote system|

Import information

0K Cancel
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In column "Import" set a tick to all access levels for which you want to import
keys from the remote key management system.

v

in the window toolbar selects all checkboxes and

x in the window toolbar unselects all checkboxes.

Click on [ in the window toolbar or on Request keys from remote
system.

If the keys are available on the remote key management system they will

be imported. This is indicated with "Success" in column "Status" and with
"Import succeeded" in the "Import information" area.

If a key is not available on the remote key management system this is indi-
cated with "Missing" in column "Status" and with "No appropriate data in
response" in the "Import information" area (in this case the OK button is not
released; untick the checkbox for the corresponding access level and repeat
the request).

Import Keys x

4.

Impart from remote system

Referenced Key Mangement System: Productive Systam

v X &

Import  Access Level Client AP Authentication Status
O [1] Data Collection 32 high level authentication using SHA-256 |-

[2] Utility Field Service 42 high level authentication using SHA-1  |Success
[2] Utility Field Service 43 high level authentication using GMAC  |Success
[2] Utility Field Service 42 high level authentication using SHA-256 |Success
[G] Management Access 1 high level authentication using SHA-1

O [G] Management Access 1 high level authentication using GMAC

O [G] Management Access 1 high level authentication using SHA-256 |-

O Role: Security Auditor 5 high level authentication using GMAC

O Role: Calibration Lab 1] high level authentication using GMAC

O Role: Communication Medule | 7 high level authentication using GMAC

O Role: Local Operator ] high level authentication using GMAC

[L] Access Administrator 2 high level authentication using SHA-1  |Success
[L] Access Administrator 2 high level authentication using GMAC  |Success
[L] Access Administrator 2 high level authentication using SHA-256 |Success

Impart information

[2] Utility Field Service - high level authentication using SHA-1

- Import succeeded

[2] Utility Field Service - high level authentication using GMAC

- Import succeeded

[2] Utility Field Service - high level authentication using SHA-256

- Import succeeded

0K LCancel

Click on OK.
The "Import Keys" window disappears and the associated device-specific
access levels are displayed.
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MName |ZM}(|'BODQ |

Type | Address | Clients

Device Specific Access Levels

[0] Public Access, no authentication

[1] Data Collecticn, static password

[2] Utility Field Service, static password

[3] Utility Service, no authentication

[G] Management Access, GMAC authentication
[L] Access Administrator, static password

[F] Manufacturer Access, static password

Import all Credentials (Offline)| [Import all Credentials (Online)
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6.2.3.5

Terminating the device data definition

1. Click on OK.
The new device definition is saved. A new entry with the defined name
appears in the device list.

&' Communication Settings

Connections | Address Book

Devices + X _'. Op Communication Channels +

Device Name  Device Series Channel Name  Interface

Default Device |undefined

Links

Communication Channel Remote Address IEC Address HDLC Address Netwerk ID Network Address

Data Version: 13 Storage Policy: permanent File Location:  C\Users\user\AppData\l ocal\l andis+GyridMAP

2. Define further devices in the same way, if required.

3. If you have imported address data from a MAP110 phone book, modify the
"undefined" device series to the appropriate device series and delete im-
ported devices which are not required.

4. Close the "Communications settings" window.

Link to communication channel is required

Each device must be linked to at least one communication channel (see section
6.2.5.1 "Defining link between device and communication channel"), so that it can
be used.

Modifying or deleting device definitions

If you intend to modify or delete a device definition, mark the corresponding
entry in the device list and then

e clickon l in the window toolbar in the "Devices" area to modify the
marked device definition or double click on the device definition.

e clickon X in the window toolbar in the "Devices" area to delete the
marked device definition. Deletions must be confirmed.
The default device definition "any device" can't be deleted.
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6.2.4 Address data

After the installation of the .MAP120 Parameter Editor, no address data
(IP addresses and phone numbers) are defined.

Proceed as described in the following subsections to generate address book
entries.

6.2.4.1 Phone numbers

Define the phone numbers required for modem connections as follows:

1. Clickon in the application toolbar or select Communication settings
from the Communication menu.
The "Communication Settings" window appears with selected tab
"Connections".

2. Select the "Address Book" tab.

#/ Communication Settings

Connections | Address Book

IF Addresses IJ Phone Numbers + IJ
Address Description Number Description

Data Version: 15 Storage Policy: permanent File Location: ~ Ci\Users\user\AppDatalocal\landis+GyridMAP

3. Clickon + in the window toolbar for phone numbers (right window).
The "Address Book" window appears.

4. Enter aclear designation of the device in the "Name" entry box and the
phone number of the desired device in the "Phone number" entry box.

Address Book

Phone

MName ZMX310G 12120973

Phone number |0763156762

Use comma to wait for dial tone e.g. 001234567
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5. Click on OK.
The "Address Book" window disappears. The phone number is saved and
then appears as entry in the address book.

#" Communication Settings

Connections | Address Book

|F Addresses + l..l Phone Numbers + I.J

Address Description MNumber Description

0763156762 | ZMX310G 12129973

Data Version: 13 Storage Policy: permanent File Location:  Ch\Users\user\AppDatahl ocal\landis+Gyr\dMAP

6. Define further phone numbers in the same way, if required.

7. Close the "Communications settings" window.

@ Modifying or deleting phone numbers

If you intend to modify or delete a phone number, select the corresponding entry
in the phone number list and then then

o clickon f in the window toolbar in the "Phone Numbers" area to
modify the marked entry of the address book or double click on the entry.

e clickon X in the window toolbar in the "Phone Numbers" area to
delete the marked entry of the address book (deletions must be confirmed).
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6.2.4.2 IP addresses

Define the IP addresses required for TCP/IP connections as follows:

1.

Click on in the application toolbar or select Communication settings
from the Communication menu.

The "Communication Settings" window appears with selected tab
"Connections".

Select the "Address Book" tab.

# Communication Settings

Connections | Address Book

IF Addresses ----- + I-I Phone Numbers + IJ

Address Description Number Description

Data Version: 15 Storage Policy: permanent File Location:  Ch\Users\user\AppDatahl ocal\landis+GyridMAP

Click on + in the window toolbar for IP addresses (left window).
The "Address Book" window appears.

Enter a clear designation of the device location in the "Name" entry box.

Select with the corresponding radio button whether an IPv4 address or an
IPv6 address or an URL shall be entered. Enter the IPv4 or IPv6 address or
the URL in the corresponding entry box and the port number of the desired
device in the "Port" entry box.

Address Book %

IP

MName Ethernet Module
Address
® P4
O pve | |192 | [168 | [200 | |20
) URL
Port 4049
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Please note that when you use an URL, a corresponding service must be active
(e.g. dyn DNS), which forwards the requests to the correct address in the
underlying network.

Click on OK.
The "Address Book" window disappears. The IP address is saved and then
appears as entry in the address book.

4" Communication Settings

Connections | Address Book
IF Addresses + I.J Phone Numbers + I.J

Address Description Number Description

192.168.200.20:4049 | Ethernet Module

Data Version: 15 Storage Policy: permanent File Location:  C\Users\user\AppDatal ocal\landis+Gyr\dMAP

Define further IP addresses in the same way.

Close the "Communications settings" window.

Modifying or deleting IP addresses

If you intend to modify or delete an IP address, select the corresponding entry in
the IP address list and then then

click on f in the window toolbar in the "IP Addresses" area to modify
the marked entry of the address book or double click on the entry.

click on X in the window toolbar in the "IP Addresses" area to delete
the marked entry of the address book (deletions must be confirmed).
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6.2.4.3 Importing address book

If the Landis+Gyr MAP110 Service Tool is already installed on the PC, its phone
book can be imported. Likewise, the address book of a Landis+Gyr .MAP tool from
another source (e.g. from another PC or another directory) can be imported.

Import an existing address book as follows:
1. Clickon in the application toolbar or select Communication settings

from the Communication menu.
The "Communication Settings" window appears with selected tab "Links".

2. Select the "Address Book" tab.

& Communication Settings

Connections | Address Book
IF Addresses IJ Phone Numbers + |4|
Address Description Number Description

Data Version: 15 Storage Pelicy: permanent File Location: ~ Ci\Users\user\AppDatalocal\Landis+GyridMAP

3. Clickon I--"r in the window toolbar for IP addresses or phone numbers.
The "Open" window appears.

4. Select in the "Open" window the phone book file to be imported (the corre-
sponding directory of the latest installed MAP110 release 3.x will be selected
by default, to directories of other .MAP releases you must navigate yourself):

- "PhoneBook.xml" for importing a MAP110 phone book or

- "AddressBookVxx.xml" (xx = data version) for importing a .MAP phone
book.

5. Click on Open.
All IP addresses and phone numbers are imported from the selected address
book if not already existing in the .MAP110 address book. The imported data
appear as entries in the IP addresses list and in the phone number list.
When a MAP110 phone book "PhoneBook.xml" has been imported, addition-
ally all device addresses are converted into devices.
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# Communication Settings

Connections | Address Book

IP Addresses + I‘I Phone Numbers + _'. x Idl
Address Description MNumber Description
192.168.1.31:5000 | Distribution West 0794438765 | ZMD405 B14.2 G21 76926068
192.168.200.20:4059 | Ethernet Module 0419356123 | ZMD405 B23.F 87541380
195.141.94.180:1000 | Training 5IM Card 4 0419356122 | ZMQ202 999939005

0419356125 | ZMG202 HOZ 76830012
0763156762 | ZMX310G

Data Version: 15 Storage Policy: permanent File Location:  C\Users\user\AppDatal ocal\landis+Gyr\dMAP

6. Close the "Communications settings" window.

7. Ifyou have imported address data from a MAP110 phone book "PhoneBook.xml",
check the device settings (see section 6.2.3 "Device data") again, since device
addresses from the imported phone book have been converted into devices.
Before you can use the device definitions created that way these have to be
linked manually with a communication channel (see section 6.2.5 "Links
between devices and communication channels").

@ Modifying or deleting address book entries

If you intend to modify or delete an address book entry, select the corresponding
address book entry in the IP address or phone number list and then then

e clickon f in the window toolbar in the "IP Addresses" or "Phone
Numbers" area to modify the marked entry of the address book or double
click on the entry.

e clickon X in the window toolbar in the "IP Addresses" or "Phone
Numbers" area to delete the marked entry of the address book (deletions
must be confirmed).
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6.2.5 Links between devices and communication channels

Device and communication channel are connected by a link in an appropriate
manner to each other (see the overview below) to allow a flexible and convenient
use.

Device (Server)
* device series
* logical device
* physical device address
* encryption keys

A
\ ]
\ /
\ /
\ Link /
\ * use of physical address ’ 4
> - remote address -
* gateway

A
|
v

Address Book
* |P addresses (IPv4, IPv6,
URL)
* phone numbers

The link determines how a device can be reached via a communication channel.

Each device must be linked to at least one communication channel, so that it can
be used.

Only the available (linked) communication channels can be selected in the
"channel" drop down list (see section 4.3.5 "Communication channel toolbar")
for a specific device.

For each device/communication channel link the following attributes can, if
required, be defined:

e |EC address (if defined for the device)

e HDLC address (if defined for the device)

e Phone number (for modem communications channels only)

e |P address and port number (for TCP/IP communication channels only)
e dIms gateway network ID and network address

If a dims device in a local network is not directly accessible, a dims gateway
must be used (e.g. Zigbee device via Ethernet gateway). The dims gateway
requires additional information in order to forward dims requests to the correct
device in the local network.

Each defined device can be linked to one or more defined communication
channels and each communication channel with one or more devices.
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6.2.5.1

Defining link between device and communication channel

Procedure:

L4

Connections | Address Book

Devices + X , cﬁp Communication Channels +

3
Click on in the application toolbar or select Communication settings

from the Communication menu.
The "Communication Settings" window appears with selected tab
"Connections". The device list and the communication list are displayed.

Communication Settings

Device Name  Device Series

AD-FE11G150 |E35C - AD=xE

Default Device undefined

b-L1 E360 - D/F/M-L1
ZMD402CT EG50/5650 - ZxD300/400
IMX310P E450 - ZxX100/300P

IMXi300Q E450 - Zxx100/300Q

Channel Name Interface

Default Channel Com1

Links
Communication Channel Remote Address |EC Address HDLC Address Netwerk ID Network Address
Default Channel [] undefined |[] undefined ] undefined [ undefined
Data Version: 13 Storage Policy: permanent File Location:  C\Users\user\AppData\local\Landis+Gyr\dMAP
2. Select a device from the device list (or alternatively a channel from the com-
munication channels list).
3. Clickon °’¢ in the window toolbar in the "Devices" area (or alterna-

tively in the "Communications Channels" area).
The "Device/Communication Channel Link" window appears with the device

fixed and the communication channel selectable:

Device / Communication Channel Link

Device AD-FE11G150

Communication Channel Default Channel
Default Channel

o Modem
Destination Server TeRp

Physical Address

[[] Use IEC address 30138859

[[] Use HDLC address 9859

[] dims Gateway
Network ID 0
Network Address Ox |00

Currently very limited support in the devices. Only enable this feature if instructed

accordingly.
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or alternatively with the communication channel fixed and the device
selectable:

Device / Communication Channel Link

Device AD-FE11G150 hd
Communication Channel AD'FE11G150 ......................................................
Default Device
-1
Destination Server ZME402CT
ZMXI0P
Physical Address ZMXi3000
D Use |EC address 39188859
[[] Use HDLC address 9859

[] dims Gateway
MNetwork 1D 0

Network Address O |00

Currently very limited support in the devices, Only enabie this feature if instructed
accordingly.

4. Inthe "Communication Channel" drop down list select one of the defined
communication channels (or alternatively in the "Device" drop down list one
of the defined devices).

5. If more than one communication channel is defined for a device, one channel
can be determined as preferred channel. When selecting this device the pre-
ferred channel is always selected as default channel. Tick for this the check-
box "This is the preferred channel for this device". The preferred channel is
then marked with a yellow star in the "Communication Settings" window.

6. Only for modem communication channels: in the "Phone Number" drop
down list select one of the defined phone numbers.

7.  Only for TCP/IP communication channels: in the "Destination Server" drop
down list select one of the defined IP addresses.

8. If the IEC or HDLC address defined for the device shall be used: set a tick to
the "Use IEC address" or "Use HDLC address" checkbox. See also section 6.3
"Addressing devices").

9. If a dlms gateway shall be used: set a tick to the "dIms Gateway" checkbox,
select a network ID and define the additional information in order to forward
dlms requests to the correct device in the local network:

— the network must be identified by a number (network ID) and

— the address of the device in the local network must be specified in the
correct format (network address).

@ dims Gateway feature not yet supported by Landis+gyr devices
Please note that the dims gateway feature is for future expansion only and not yet
supported by the Landis+Gyr devices. For the time being make sure to disable it.
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6.2.5.2 Terminating the link definition

1.

Click on OK.
The "Device/Communication Channel Link" window disappears and the new
defined link is displayed in the communication channel links list.

If more than one communication channels shall be usable to access the
device (or alternatively if more than one device shall be accessible via the
communication channel), define another link the same way.

#/ Communication Settings

Connections | Address Book

Devices + X _’ 4’0 Communication Channels +

Device Name  Device Series Channel Name Interface
AD-FE11G150 |E35C - AD-=xE
Default Device |undsfined

b-L1 E360 - D/F/M-L1 TCP-IP Realtek PCle GBE Family Controller - 192.168.1.20
ZMD402CT E650/5650 - ZxD300/400 USE - Optical Head - 9600 | COM5
IMX310P E450 - ZxX100/300P

Links

Communicaticn Channel Remote Address |EC Address HDLC Address Metwork ID Metwork Address
TCP-IP Distribution West 1/ undefined |1 undefined | undefined |[]| undefined

* | USB - Optical Head - 9600 39188859 9859 [ undefined [ undefined

Data Version: 15 | Storage Policy: permanent File Location: ~ CAUsers\user\AppData\l ocal\landis+ GyridMAP

3. Define the links for all devices (or alternatively for all communication
channels) the same way.
4. Close the "Communications settings" window.
@ Modifying or deleting links
If you intend to modify or delete a link, select the corresponding entry in the link
list and then
e clickon f in the window toolbar in the "Links" area to modify the
marked entry of the link list or double click on the entry.
e clickon X in the window toolbar in the "Links" area to delete the

marked entry of the link list (deletions must be confirmed).

Note: Links related to the default device "Default Device" can't be deleted, they
only can be edited.

© Landis+Gyr
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6.3 Addressing devices

For point-to-point connections, the device does not need to be specially addressed.
However, with multi-drop, all devices connected to a bus system (RS485 or CS)
must have their own address for individual access. This address is called the
physical device address. In fact, even two physical device addresses are used, one
for the IEC protocol (IEC device address) and the other for the DLMS protocol
(HDLC device address).

Unless otherwise specified on the order, the following parameter values are set as
defaults for these physical device addresses:

e Physical IEC device address = serial number (printed on face plate of device),
e.g. 73852799.

e Physical HDLC device address = last 4 digits of serial number plus 1000
(because with dims the range of addresses is limited and some addresses are
reserved), e.g. 3799 for a serial number 73852799 (2799 + 1000 = 3799).

The physical device addresses are saved as parameters of the basic meter and not
in the possibly used E65C communication unit. A change of the E65C communica-
tion unit does therefore not affect the addressing. With the Landis+Gyr .MAP110
Service Tool, the physical device addresses of the devices can be read with the
read commands under "Communication" or modified with the write commands
under "Communication".

6.4 Establishing the communication with devices

Once the communication settings have been made (see section 6.1 "Basic
principle") the communication with a device can be established as follows:

e Select (optional) the required device from the "Device" drop down list or use
the setting "any device".

e Select the required communication channel from the "Channel" drop down
list.
Only those communication channels linked to the selected device are avail-
able. In the case of "any device" all communication channels are available.

e Select the required access level from the "Client" drop down list (for modem
connections the predefined access level is used and the drop down list is
inhibited until the connection is established, then the selection is possible).
Only access levels, which have been defined completely in the communication
settings, are displayed for selection (see also section 6.2.3.3 "Access levels").
The device-specific access levels appear with attached device name at the top
of the list.

e Only for modem connections: select the required phone number from the
"Phone" drop down list.

e Only for modem connections: click on in the address toolbar to establish
the connection to the device.

e Only for network connections: select the required IP address number from the
"IP Address" drop down list.

e Perform the intended activity.
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6.5

6.5.1

Communication examples

This section provides some examples to show how communication connections
are made to devices via various communication paths and for various applicati-
ons:

Serial connection via the optical interface (see section 6.5.1)
Modem connection (see section 6.5.2)
Network connection via a LAN (see section 6.5.3)

Network connection via a WLAN and the Internet (see section 6.5.4)

It is assumed in all examples that the physical connections (e.g. cable or modem
connections) have already been made and the Landis+Gyr .MAP120 Parameter
Editor has already been started.

Serial connection via the optical interface

This example shows how a local connection is made to a device via the optical
interface. Depending on the device series used dlms or IEC is used as communica-
tion protocol.

E450 meter
PC with .MAP120 ZMX300Px

_ Optical

reading
head

Serial connection
(USB or COM port)

Procedure:

1.

In the "Device" drop down list, select the desired device (e.g. E450 meter)
and in the "Channel" drop down list the corresponding channel (if more than
one channel is assigned to this device) or create a new device definition with
the following settings (procedure see section 6.2.2 "Communication channel
data" and section 6.2.3 "Device data"):

- Physical interface = COM-Port assigned to the serial interface
- Interface Type = Serial (optical head or 3-wire)

- Template for lower layer settings = Serial — dlms or "Seriell — IEC"
according to the device used.

In the "Client" drop down list select the required access level for the
intended activity e.g. "[2] Utility Field Service".

Perform the intended activity.

Landis+Gyr
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6.5.2 Modem connection

This example shows how a point-to-point connection is made for remote commu-
nication with an E450 ZMX300Gx meter (with 2G/3G communication module).

E450 meter
ZMX300Gx

PC with .MAP120

GSM

Procedure:

1.

In the "Device" drop down list, select the desired device (e.g. E450 meter)
and in the "Channel" drop down list the corresponding channel (if more than
one channel is assigned to this device) or create a new device definition with
the following settings (procedure see section 6.2.2 "Communication channel
data" and section 6.2.3 "Device data"):

- Physical interface = The available PSTN or GSM modem
- Template for lower layer settings = PSTN or GSM modem

In the "Client" drop down list select the required access level for the
intended work e.g. "[G] Management Access".

In the "Phone" drop down list select the required phone number of the
connected device. If not already predefined, define it (for procedure see
section 6.2.4 "Address data").

Click on in the address toolbar to make connection to the modem.
While making the connection the Command" window is displayed with a
progress indication.

When the connection is made, it is indicated in the status bar.

Perform the intended activity.

Click on in the address toolbar to conclude the modem connection when
the work is done.
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6.5.3 Network connection via a LAN

This example shows how a point-to-point connection is made via a LAN to a single
E350 meter equipped with a communication module AD-xE.

E350 meter with

PC with .MAP120 Ethernet module
. T

Switch or Router

Ethernet Ethernet

Procedure:

1.

In the "Device" drop down list, select the desired device (e.g. AD-xE Ethernet
module) and in the "Channel" drop down list the corresponding channel (if
more than one channel is assigned to this device) or create a new device
definition with the following settings (procedure see section 6.2.2 "Commu-
nication channel data" and section 6.2.3 "Device data"):

- Physical interface = The available network card

- Template for lower layer settings = Wired — HDLC or "Wired — Wrapper"
according to the device used.

In the "Client" drop down list select the required access level for the
intended work e.g. "[2] Utility Field Service".

In the "IP Address" drop down list select the required IP address of the
connected device. If not already predefined, define it (for procedure see
section 6.2.4.2 "IP addresses").

Perform the intended activity.

© Landis+Gyr
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6.5.4 Network connection via a WLAN and the Internet

This example shows how a point-to-point connection is made via a WLAN and the
Internet to a single E350 meter equipped with a communication module AD-xG.

E350 meter with

PC with .MAP120 GPRS module
: » -

Procedure:

1.

4.

In the "Device" drop down list, select the desired device (e.g. AD-xG GPRS
module) and in the "Channel" drop down list the corresponding channel (if
more than one channel is assigned to this device) or create a new device
definition with the following settings (procedure see section 6.2.2 "Commu-
nication channel data" and section 6.2.3 "Device data"):

- Physical interface = The available WLAN network card

- Template for lower layer settings = "Wireless — HDLC" or "Wireless —
Wrapper" according to the device used.

In the "Client" drop down list select the required access level for the
intended activity e.g. "[7] Remote Service".

In the "IP Address" drop down list select the required IP address of the
connected device. If not already predefined, define it (for procedure see
section 6.2.4.2 "IP addresses").

Perform the intended activity.

6.6 Reference to other documents

Detailed information about Landis+Gyr Dialog communication solutions can be
found in the following documents.

Data sheets for various devices
User manuals for various devices
Functional descriptions of devices

Detailed application notes for numerous reference applications with various
devices for different transmission media

All these documents as well as advisory services are available from the competent
representative of Landis+Gyr.
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7 Auxiliary functions

This section describes auxiliary functions of the Landis+Gyr .MAP120 Parameter
Editor:

Converting ASCII to text or vice versa

Changing the language of the user interface
Defining colours

Switching the saving prompt on and off

Defining storage location of communication settings
Defining storage policy for keys and passwords
Displaying tool help

Displaying release notes

Displaying the current program release and checking for updates

7.1 Converting ASCII to text or vice versa

This function allows conversion of ASCII code into text or vice versa.

Procedure:

1.

Select ASCII character converter from the Tools menu.
The "ASCIl Character Sequence to Text Converter" window appears.

Enter a hexadecimal ASCII character sequence or a text string in the
corresponding entry box.
The converted text or sequence is displayed immediately.

ASCII Character Sequence to Text Converter

Hexadecimal ASCIl Character Sequence:

616263414243

Text:

abcABC

Copy Hex Stream Copy Text

Click on Copy Hex Stream to copy the content of the hexadecimal ASCII
character sequence box into the Windows clipboard or click on Copy Text to
copy the content of the text box into the Windows clipboard.

You then can insert this to any place using the paste function [Ctrl]+[V].

Click on Exit to close the "ASCII Character Sequence to Text Converter"
window.

Landis+Gyr
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7.2 Changing the language of the user interface

This function allows changing the language of the .MAP120 Parameter Editor user
interface.

Procedure:

1. Select Startup language from the Tools menu.
The "Startup Language" window appears.

Startup Language

English v

2. Select the desired language in the drop down list.
English and German are available.

3. Click on OK.
The "Startup Language" window disappears.
The selected language will be used upon the next startup of the .MAP120
Parameter Editor.

7.3 Defining colours

The colour for modified values in comparisons can be set with this setting.

Procedure:

1. Select Options from the Tools menu.
The "Options" window appears with selected "General" tab.

General | Communication Settings | Key Mangement System

Caolours

Colour of differences in file comparison I:I

Prompt

Prompt to save changed device description before closing

2. Inthe "Colours" area click on the button 'E}
The "Colour" window appears with a colour palette.

3. Select the desired colour and click on OK.
The "Colour" window disappears and the selected colour is shown in the field
"Colour of differences in file comparison".
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4. Click on OK.
The "Options" window disappears and the selected colour will be saved.

7.4 Switching the saving prompt on and off

With this setting, you can specify whether a saving prompt shall appear when
closing a modified device description or not.

Procedure:

1. Select Options from the Tools menu.
The "Options" window appears with selected "General" tab.

General | Communication Settings | Key Mangement System

Caolours

Caolour of differences in file comparison I:l

Prompt

Prompt to save changed device description before closing

2. Tick the checkbox in the "Prompt" area if a saving prompt shall be displayed
before closing a changed device description or remove the tick if you do not
want to get a prompt.

3. Click on OK.

The "Options" window disappears and the saving prompt setting will be
saved.
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7.5 Defining storage location of communication settings

The path to the directory where communication settings are stored can be
defined with this setting.

The communication settings can be shared for all .MAP tools.

Since the keys, passwords and the storage policy are stored encrypted per
Windows user, the communication settings cannot be used by other Windows
users on the same PC.

Procedure:

1. Select Options from the Tools menu.
The "Options" window appears with selected "General" tab.

2. Select the "Communication Settings" tab.

3. Inthe "File Locations" area click on " | and select a directory in the tree
appearing or enter the path to the desired directory.

General | Cormmunication Settings | Key Mangement System

File Location

ChlUserstuserAppDataiLocallandis+GyrdMAP | |I|

Storage Policy of Keys and Passwords

) permanent
A change of the storage
®) never I policy leads to the deletion
. of all keys and passwords.
) limited undtil 25 . Movember

4. Click on OK.
The "Options" window disappears and the new settings are saved.

All communication settings are stored in the files "DeviceConnectionSettings
Vxx.xml", "AddressBookVxx.xml" and "SecuritySettingsVxx.xml" (xx = data version,
e.g. 12). Please note that these files will not be automatically transferred into the
new directory. If required, the files have to be copied or moved manually.

The default directory for an initial installation is "C:\Users\Current
User\AppData\Local\Landis+Gyr\dMAP".
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7.6 Defining storage policy for keys and passwords

With this setting, you can set the storage policy for passwords and keys.

® Data deletion with each modification
Any modification in the storage policy causes a deletion of all passwords and keys.

Procedure:

1. Select Options from the Tools menu.
The "Options" window appears.

2. Select the "Communication Settings" tab.
General | Communication Settings | Key Mangement System

File Location

ChlUsershuserAppDatatLocallandis +GyrdMAP | IZ‘

Storage Policy of Keys and Passwords
) permanent

A change of the storage
(@) never | policy leads to the deletion
- of all keys and passwords.
) limited until 25 . November 2019

3. Select the desired storage policy.
permanent: The passwords and keys are permanently stored on the PC.

never: The passwords and keys are not stored, i.e. they will be lost when you
exit the .MAP tool.

limited until: The passwords and keys are stored on the PC until the specified
expiration date is reached on the PC, and then deleted.

4. Click on OK.
The "Options" window disappears and the new settings are saved.

© Landis+Gyr D000043592 en n —.MAP120 — Parameter Editor — User Manual



Auxiliary functions

109/132

7.7 Defining the key management system

With this setting, you can set the credentials for accessing the productive and test
key management system.

@ Required credentials
All required credentials will be supplied to you by your Landis+Gyr representative.

Procedure:

1. Select Options from the Tools menu.
The "Options" window appears.

2. Select the "Key Management System" tab.

General | Communication Settings | Key Mangement System

Referenced Key Mangement System

Key Management System (Productive) | Key Management System (Test) | Renaming | Logging

Url

User

Password

Certificate

Key Label |WK_LG

4

'
'

Key Encryption Key (KEK)

KEK Share 1

KEK (Hash)

P4 KEK Share 2 rd

3. Inthe selection box "Referenced Key Management System" select
"Productive System".

4. Click on

d

behind the "Url" entry box.

The "Url" window appears.

5. Enter the server name in the "Server" entry box and the port number in the
"Port" entry box.
The resulting Url is displayed in the corresponding box underneath.

Url

Server localhost

Port 8081

Resulting Url | https://localhost:B081/ATM-KeyManagement-REST-Service/service/rest/|
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6. Click on OK.
The "Url" window disappears and the Url is displayed in the corresponding
entry box in the "Options" window.
7. Enter the user name in the "User" entry box.
8. Click on " behind the "Password" entry box.
The "Enter new password (secret)" window appears.
9. Enter the password as visible string in the "Password (secret)" entry box.
Enter new password (secret)
Password (secret)
& visible string |oe7s432 | @
hexadecimal characters 8/255
10. Click on OK.

11.

12.

The "Enter new password (secret)" window disappears and the password is
displayed with asterisks in the corresponding entry box in the "Options" win-
dow.

Click on behind the "Certificate" entry box.

The "Certificate" window appears.

Enter the certificate name in the "Certificate" entry box.
Klick on Look-up to decrypt the certificate and display the details of the
certificate.

Certificate x

Certificate |Certificate_12345 | |Look-up|

Distails Certificate information: LddressBook ~
Store: Zddre=ssBook
Subject: E=susanne.s'
Effective date: 23.10.2015 1
Expiration date: 22.10 171
Issuer: CH=5IX-Grou]
Key algorithm: 1.2.840.113!
Certificate hash: E75B45B18B4]
Public key: 30820100028,
Serial number: 052a1F81105]
Subject: E=thomas.hi:
Effective date: 01.04.2015 |

13.

14.

15.

16.

Click on OK.
The "Certificate" window disappears and the certificate name is displayed in
the corresponding entry box in the "Options" window.

Enter an unambiguous key label in the "Key Label" entry box.
Default value is "WK_LG".

Click on i behind the "KEK Share 1" entry box.
The "Enter Key Encryption Key" window appears.

Enter the key encryption key share 1 (part 1) as hexadecimal string in the
"KEK Share 1" entry box.

© Landis+Gyr
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Enter Key Encryption Key

KEK Share 1

wvisible string

® hexadecimal

Ux‘ FFFEFDFCFBFAFOFBFTFEFSFAF3F2F1FOFFFEFDFCFBFAFOFBFTFEFSFAFIFZFIFD | o

characters 32/64

OK Cancel

17. Click on OK.
The "Enter Key Encryption Key" window disappears and the key encryption
key is displayed with asterisks in the corresponding entry box in the "Options"
window.

18. Enter the key encryption key share 2 (part 2) in the same way.
The key encryption key hash value is calculated out of the two parts entered
and displayed in the "KEK (Hash)" box.

General | Communication Settings | Key Mangement System

Referenced Key Mangement System | Productive System

Key Management System (Productive) | Key Management System (Test) | Renaming | Logging

Url https://localhost:8081/ATM-KeyManagement-REST-5ervice/service/rest/crypto/getkeys _"
User Henry Miller

-------------------- 2
Password 4
Certificate |Certificate_12345 rd

Key Label |WEK_LG

Key Encryption Key (KEK)

KEK Share 1

KEK (Hash)

,,,,,,,,,, ’~ KEK Share 2 | <eesess ’.

4558598 C19E4480670E163D26305302B5BFADIED |

19. Inthe selection box "Referenced Key Management System" select "Test
System" and repeat points 4 to 18.

20. Select the "Renaming" tab if the key management system used has to be
identified with a client name instead of a COSEM client ID.
The relation between the COSEM client ID and the client name is defined in
the file "KMSClientIDMapping.xml". This file has to be adapted according to
the key management system used.

21. Tick the checkbox on the "Renaming" tab and click on D to select the
folder with the file "KMSClientIDMapping.xml" in the "Open" window which
then appears or enter the path to the file in the entry box.
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General | Communication Settings | Key Management System

Referenced Key Management System | Productive System

Key Management System (Productive) | Key Management System (Test) | Renaming | Logging
Use Client Mame instead of Client ID to query the KMS:
Ch\Users\user\DocumentstLandis+GyridMAP1 200, SA\KMS ClientiDMapping.ml E

Some KMS use instead of COSEM Client ID a free text field to identify the COSEM access client.
In this case the MAP tools have to query the customer KMS using this text os identifier,

The relation between the Client [D and the Client Name is defined in the xml file given above.
If renaming is used, adapt this file accordingly.

22. Select the "Logging" tab if the queries to the key management system shall
be logged.

23. Tick the checkbox on the "Logging" tab and enter the path and the desired
name of the log file in the entry box.

The log file will then be created automatically in the corresponding folder.

As default value the file name "KMSLog.txt" and the default folder of the
used .MAP120 version is used.

If you have already created a log file, click on D to select the folder and the
file in the "Open" window which then appears.

General | Communication Settings | Key Management System

Referenced Key Management System | Productive System *

Key Management System (Productive) | Key Management System (Test) | Renaming | Logging

Log File
Ch\Usershuser\DocumentshLandis+ Gy dMAP1 200, S\KMSLog. bt D
24. Click on OK.

The "Options" window disappears and the new settings are saved.
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7.8 Displaying tool help
This function permits access to the help texts for the Landis+Gyr .MAP120 Para-
meter Editor. These help texts correspond to the contents of this user manual.
Procedure:

1. Press function key [F1] or select Help from the Help menu.
The online help for the Landis+Gyr .MAP120 Parameter Editor appears.

E? MAP120 Help

2 n & O

Ausblenden  Furiick Drucken  Optionen

Inhalt | Index I guchenl

Overview
@ Licensing Previous MNext
Q Description of user inteface B ) B 3
Q Device description functions The Landis+Gyr .MAP120 Parameter Editor supports services needed to edit and A
@ Communication with devices download complete device descriptions (parameterisations) into the supported
@ Augiiary functions Landis+Gyr devices.
@ Support

The following diagram illustrates the various fields of application of the
Landis+Gyr MAP and .MAP Tools.

- e

: Parameter- Test + .
Conﬁgurauan)> o) ) Vo e tlnstallauon ’Zﬂeadout ’, N

MAP180/120 ’

.MAP120

@ Short description of deviee s
@ 0BIS identification codes
@ List of abbreviations

.MAP110

Further information:
O Functions

[0 Communication channels v

< >

2.  Find the desired information.
Since the help function is a standard Windows function, it will not be
explained at this point. More details are found in the Windows manual
belonging to your PC.

3. Click on Bl to close the online help.
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7.9 Displaying release notes

This function displays the latest read-me file.

Procedure:

1. Select Release notes from the Help menu.
The latest read-me file appears.

MAP120 - Release Motes

1. Description ~

The Landis+Gyr MAP120 Parameter Editor is used to create and edit complete device description files.
It allows the reading and writing of such files from and to devices of the E450, E460, E570 and E35C series using vi
For all other service functions Landis+Gyr . MAP 110 must be used.

2. Most recent changes, enhancements and bug fixes

Changes to release 4.3.24 (2018-11-30)

- Final device support E570 52 G3 PLC V83050548

- Final device support E570 52 GPRS V840505.48

- Final device support E460 51G3 PLC 1ph BS V770100.07
Changes to release 4.3.08 (2018-08-27)

- Device support of ES70 52 G3 PLC VB30505.35

- Device support of E570 52 GPRS WB40505.35
- Device support of E460 51 G3 PLC 1ph BS V770100.07 N
£

2. Obtain the information you are interested in.

3. Click on Close to close the read-me file again.

© Landis+Gyr
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7.10 Displaying the current program release and checking for updates

This function permits the display of information on the current program release
and checking whether the installed .MAP120 release is up to date.

@ Internet access required
To perform a check for updates the PC must have access to the Internet, since the
.MAP Home Page must be contacted for this.

Procedure:

1. Select About .MAP120 from the Help menu.
The "About" window appears. It contains information about the current
version, the license and the operating system and .NET Framework installed
on this computer.

Landis+Gyr .MAP120 - Parameter Editor

Version Information

Version 4529 &0 Updats

Date 2019-11-26
Build 45726030722 (2019-11-28)
License
User name Felix Baetschmann
User group Head Quarter
Landis
Gyr+ System Information

Operating System Windows 10 Professional Edition (84Bit)

. . NET Framework 473190
http:/fwww landisgyr.com

Copyright € Landis+Gyr AG, 2019

2. Click on Check for Update if you want to check whether the installed
.MAP120 release is up to date.
An automatic query is performed on the .MAP Home Page to determine the
latest released release available.

Landis+Gyr .MAP120 - Parameter Editor

Version Information

Versicn 4520 ‘@ Update
Date 2019-11-28 o
o
Build 45726930722 (2019-11-26) "..
License
User name Felix Baetschmann
User group Head Quarter
Landis
Gyr+ System Information

Operating System Windows 10 Professional Edition (64Bit)

. . NET Framework 47.3190
http-/lwww landisgyr com

Copyright & Landis+Gyr AG, 2019

OK
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.

The «.+"icon is displayed while the query is performed.

Landis+Gyr .MAP120 - Parameter Editor

Versicn Information

Version 4520 %D Update

Date 2019-11-26
Build 45726930722 (2019-11-26) v
License
User name Felix Baetschmann
User group Head Quarter
Landis
Gyr+ System Information

Operating System Windows 10 Professional Edition (64Bit)

‘ . MET Framework 47.3190
http:/iwwnw landisgyr.com

Copyright € Landis+Gyr AG, 2019

The Q? icon is displayed, if the installed release is up to date.

If a later release is available, the & icon appears. To download and install
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8 Support

The following is designed to help you take the right measure to tackle any pro-
blems you may experience when using the Landis+Gyr .MAP120 Parameter Editor.

If a problem arises try to solve it yourself first by applying the following measures:
e Consult the appropriate section of this user manual.
e Invoke the help function as described in section 7.8 "Displaying tool help".

e Read the content of the read-me file, supplied with the software as described
in section 7.9 "Displaying release notes".

If these measures do not help, contact your local Landis+Gyr representative.
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Short description of device security system

9 Short description of device security system

9.1 Introduction

The data and parameters of the Landis+Gyr devices are protected against un-
intended or improper access by a flexible, multi-stage security system. It is very
similar to the one used in computer systems and consists of several access levels
(users) with different access rights.

Detailed information on the security system for the relevant devices is provided in
the corresponding functional descriptions.

9.2 Security attributes

Switches protected by
the verification seal

Entering the service
menu

Access authentication

Passwords/Keys

Communication channels

Landis+Gyr

For each access level, various security attributes can be defined that must be
fulfilled to gain access.

Protected by the verification seal, there is for many devices (e.g. under the main
face plate) a block of security switches or jumpers. Their position must be defined
in order to gain access to a particular level.

It may be defined that access to a certain level will only be granted from the
service menu. To enter the service menu, the utility seal must be removed.

For each access level it is defined how the authentication has to be performed.
The following authentication types are defined:

e no authentication (access possible without password)

e |low level authentication using a static password

e high level authentication using a coded password

e high level authentication using TEA (Tiny Encryption Algorithm)

e high level authentication using MD5 (Message-Digest Algorithm 5)

e high level authentication using SHA-1 (Secure Hash Algorithm)

e high level authentication using SHA-256 (Secure Hash Algorithm)

e high level authentication using GMAC (Galois Message Authentication Code)
In some cases multiple authentication types are selectable per access level.

If a static password is used, the user only needs to know the password. It is
checked by the device and access is granted if the passwords match.

For all other passwords and keys the user not only needs to know the password
but also an encryption algorithm. Due to the encryption, a Landis+Gyr tool is
required to access such a level.

A password or a key must be defined for some authentication types. Static and
coded passwords as well as SHA keys comprise 16 characters, TEA and MD5 keys
32 characters.

The access to a certain level may be restricted so that it is only granted via
selected communication channels. Access is for instance possible via the optical
interface, the integrated interface and both communication channels of the
communication unit.
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Message security

9.3 Access levels

9.4
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To ensure the message safety, the messages can be authenticated and/or en-
crypted, provided a high level authentication using MD5, SHA or GMAC is used for
access authentication. The necessary keys are stored in one or several security
setup objects.

The Landis+Gyr devices feature up to 15 different access levels with different
access rights to groups of registers and parameters. The access rights per group
(read and write access) can be individually configured for every access level.

Each access level is protected by security attributes which must be fulfilled to gain
access. In order to simplify the handling and to ensure compatibility to other
device series, most of the security attributes have been partially or completely
fixed.

All access levels are technically strictly independent i.e. a higher access level does
not automatically bear all rights of the lower access levels.

Access levels and their application

The table below describes all access levels with their security attributes and their
typical application. The access rights are defined by the utility when ordering the
device. They depend on the needs of the utility and on the national regulations.

For levels 0 to 4 access is possible via the dims and the IEC protocol, for levels 5 to
G via the dIms protocol only. The UID (user identification) is used in dims commu-
nication to select the access level.

Please note that not all access levels are available in all devices, the table below
therefore just gives an overview. Please always refer to the functional description
of the currently used device.

Level

Security attributes Access rights and typical application examples

0
Public Access
uiD =16

without password This access level is always available. All dlms devices can be

without breaking a seal accessed on this level.

all interfaces Some data can be read but there is no write access.

1
Data Collection
UiD =32

with static password or high
level authentication

Readout of billing data by means of a handheld terminal or

possibly by a central system.
without breaking a seal All billing data is readable.

interfaces selectable Limited write access possible, e.g. time/date.

2
Utility Field Service
UID =48

with coded password, Maintenance tasks.
encryption key or high level

authentication

All parameters and all billing data are readable.

Limited write access to uncritical data is possible, e.g.
device addresses, identification numbers, phone numbers
etc.

without breaking a seal
interfaces selectable
Landis+Gyr Tool required if
coded password or

encryption algorithm is
used.
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Extended Utility Service
UID =80

Level Security attributes Access rights and typical application examples
3 without password Installation or maintenance work in the utility and in the
Utility Service breaking the utility seal field.
UiD =64 necessary All parameters and all billing data are readable.
local interfaces only Limited write access to settable data is possible, e.g. battery
operating time, switching tables etc.
4 without password Installation or maintenance work in the utility. Verification

breaking the verification
seal necessary

local interfaces only

is usually required afterwards.
All parameters and all billing data are readable.

Write access to all data is possible, e.g. parameterisation,
register clearing, password setting etc.

5
Extended Consumer
uiD=17

with static password
without breaking a seal

interfaces selectable

Write access for the end user.
All parameters and most billing data are readable.

Limited write access to the end user data is possible, e.g.
monitor thresholds.

6
Remote Data Collection
uiD =18

with static password
without breaking a seal

remote interfaces only

Remote readout of billing data by a central system.
All billing data is readable.

Limited write access is possible, e.g. time/date.

Access Administrator
uiD=2

7 with static password Installation or maintenance work in connection with a

Remote Service without breaking a seal central system.

uID = 19 remote interfaces only All parameters and all billing data are readable.
Limited write access to settable data is possible, e.g.
switching tables, device addresses, identification numbers,
phone numbers etc.

G with static password or high | Installation or maintenance work after verification (locally

Management level authentication or via a central system).

UiD=1 without breaking a seal All parameters and all billing data are readable.

all interfaces Limited write access to settable data is possible, e.g.

switching tables, device addresses, identification numbers,
phone numbers etc.

L with static password or high | The same purpose as Level G, additionally the access rights

level authentication
without breaking a seal

all interfaces

of the other levels can be modified.

Read Administrator
UID =96

8 Reserved for future expansion.

9 without breaking a seal Pre-established, to send unconfirmed messages to multiple
Broadcast remote interfaces only devices (broadcast) not available in .MAP tools.

UID =102

A attributes selectable at No typical application defined.

Utility Defined ordering time Access rights defined at ordering time according to the

uID = 22 needs of the utility.

B Reserved for future expansion.

C with static password Allocation of read access rights

without breaking a seal

All parameter and all billing data are readable.

Read access rights for all lower levels (0 to B) can be
allocated.

Landis+Gyr
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Level

Security attributes

Access rights and typical application examples

D
Utility Administrator
UID =97

with coded password

breaking the verification
seal necessary

local interfaces only

Landis+Gyr Tool required
because of coded password

Same as level 4.

In addition, changes in the utility security system are
possible:

Read and write access rights can be adapted and all
passwords can be changed.

E
Distributor Service
UID = 100

with coded password

breaking the verification
seal necessary

local interfaces only

Landis+Gyr Tool required
because of coded password

Service access of the distributor.
Identical to level D.

In addition, changing the access rights and the password of
the utility administrator is possible.
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10 OBIS identification codes

10.1 General description

Group A

Group B

Group C

Landis+Gyr

For OBIS (Object Identification System) the structure A-B:C.D.E.F applies, whereby
the individual groups have the following significance:

A Defines the characteristic of the data item to be identified, e.g. abstract
data, electricity-, gas-, heat- or water-related data.

B Defines the channel number, i.e. the number of the input of a metering
equipment having several inputs for the measurement of energy of the
same or different types (e.g. in data concentrators, registration units). This
enables data from different sources to be identified.

C Defines the abstract or physical data items related to the information
source concerned, e.g. active power, reactive power, apparent power,
power factor, current or voltage.

D Defines types, or the result of the processing of physical quantities accord-
ing to various specific algorithms. The algorithms can deliver energy and
demand quantities as well as other physical quantities.

E Defines the further processing of measurement results to tariff registers,
according to the tariffs in use. For abstract data or for measurement results
for which tariffs are not relevant, this value group can be used for further
classification.

F Defines the storage of data according to different billing periods. Where
this is not relevant, this value group can be used for further classification.

To simplify the reading in the index field, individual groups of the OBIS code can
be omitted. The abstract or physical data C and type of data D must be shown. A
full specification of the OBIS identification number system can be found in
standard IEC 62056-61.

Only the values of interest to metering devices are explained below with a collec-
tion of examples.

Group A of the OBIS identification can theoretically have values in the range
between 0 and 9. Only the values

0 (abstract objects) and

1 (electricity related objects)

appear in the Landis+Gyr .MAP120 Parameter Editor.

Group B of the OBIS identification can theoretically have values in the range
between 0 and 64. Only the values

0 (no channel specified)

1 (channel 1) and

2 (channel 2)

appear in the Landis+Gyr .MAP120 Parameter Editor.

Group C of the OBIS identification can have values in the range between 0 and
255. The individual values are differently assigned depending on the value of
group A. The values for abstract items (group A = 0) are of no interest at this
point, since they are largely specific to either context, country or manufacturer.
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The following table shows the values of group C of the OBIS identification for elec-
tricity related objects. It has the form of a matrix and is read as follows: the value
46 for instance stands for reactive power in the second quadrant for phase L2.

General purpose objects 0

Active power +A (Q+QIv) ¥ sL 1| L 21| L 41| L, 61
Active power -A (Qui+Qli) SL 2 L 22| L, 42| L3 62
Reactive power +R (QI+Qll) SL 3 L, 23| L 43| Ly 63
Reactive power -R (QlI+QIV) SL 4 L, 24| L, 44| L, 64
Reactive power +Ri (Ql) SL 5 L, 25| L, 45| Ly 65
Reactive power -Rc (Ql) SL 6 L, 26| L 46| L; 66
Reactive power -Ri (Qu) SL 7 L 27| L, 47| L3 67
Reactive power +Rc (Q IV) SL 8 L,b, 28| L, 48| L; 68
Apparent power +VA (Ql +QIV) YL 9 L 29| L, 49| L; 69
Apparent power -VA (QlI+Qlll) >L 10 LL 30| L 50| Ly 70
Current 2 1y 31| L, 51| L, 71
Voltage 2 12|, 32| L 52| L 72
Power factor > L 13 L, 33 L, 53 Ls 73
Supply frequency 14 LL 34| L, 54| Ly 74
Active power [+A]+]-A| 15 L, 35| L 55| Ly 75
Active power [+A]-]-A] 16 LL 36| L, 56| Ly 76
Active power +A (Ql) 17 LL 37| L, 57| Ly 77
Active power -A(Qll) 18 L, 38| L, 58| Ly 78
Active power -A (QllN) 19 L, 39| L 5| Ly 79
Active power +A (QIV) 20 L, 40| L, 60| Ly 80
Phase angles 81

Neutral current 91

Neutral voltage 92

Service entries * 96

Error messages 3 97

List objects 3 98

Data profiles 3 99

1)

Ql, all, Qlll, QlV =Quadrant 1, 2, 3,4

2 any phase

% In all data readouts the OBIS code is shown in .MAP tools in numeric format only (as

defined in the standard) instead of partly using characters. Affected values: "C"=96,
"F"=97, "L"=98 and "P"=99. This now allows a correct referencing to the standard.
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Group D

Group E

Group F

10.2 Examples

Landis+Gyr

OBIS identification codes

The values 128 to 255 have manufacturer-specific definitions.
Some examples of Landis+Gyr definitions are:

Value Application

130 Sum of all phases: reactive power quadrant I+IV+lI+llI
131 Sum of all phases: reactive power quadrant I+lI-IlI-IV
132 Sum of all phases: reactive power quadrant I+IV
133 Sum of all phases: reactive power quadrant II1+l1I
150 Phase 1: reactive power quadrant I+IV+lI+llI

151 Phase 1: reactive power quadrant [+I-11I-1V

152 Phase 1: reactive power quadrant |+IV

153 Phase 1: reactive power quadrant ll+lll

170 Phase 2: reactive power quadrant I+IV+lI+ll|

171 Phase 2: reactive power quadrant I+I-11I-1V

172 Phase 2: reactive power quadrant |+IV

173 Phase 2: reactive power quadrant lI+lll

190 Phase 3: reactive power quadrant I+IV+lI+ll|

191 Phase 3: reactive power quadrant I+I-11I-1V

192 Phase 3: reactive power quadrant |+IV

193 Phase 3: reactive power quadrant lI+lll

Group D of the OBIS identification can have values in the range between 0 and
255. The individual values are differently assigned depending on the value of
group A and C, but are not described here.

Group E of the OBIS identification can have values in the range between 0 and
255. In the Landis+Gyr .MAP120 Parameter Editor for group E for electricity-
related items (group A = 1) the values corresponding to the number of tariffs
specified mainly appear (0 = total of all tariffs, 1 = tariff 1, 2 = tariff 2, etc.). Other
values apply for specific values of group C, but these are not described here.

Group F of the OBIS identification can have values in the range between 0 and
255. In the Landis+Gyr .MAP120 Parameter Editor group F is not used and is
therefore always set to 255.

The following table shows a selection of OBIS identification numbers and explains
their significance.

OBIS code OBIS code (hex) Description

(decimal) ABCDETE

0-0:1.0.0 00 00 01 00 00 FF Clock

0-0:42.0.0 00 00 2A 00 00 FF dims device identification
0-0:96.1.0 00 00 60 01 00 FF Identification number 2.1
0-0:96.1.1 00 00 60 01 01 FF Identification number 2.2
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OBIS code OBIS code (hex) Description

(decimal) ABCDETE

0-0:96.2.0 00 00 60 02 00 FF Number of parameterisations

0-0:96.2.1 00 00 60 02 01 FF Date and time of last parameterisation

0-0:96.2.2 00 00 60 02 02 FF Activation date TOU

0-0:96.2.3 00 00 60 02 03 FF Date of last RCR program change

0-0:96.240.0 00 00 60 FO 00 FF EEPROM identification

0-0:96.240.13 00 00 60 FO OD FF Hardware ID

0-0:96.3.1 00 00 60 03 01 FF Input terminal states base meter

0-0:96.3.2 00 00 60 03 02 FF Output terminal states base meter

0-0:96.4.0 00 00 60 04 00 FF Internal control signal states

0-0:96.5.0 00 00 60 05 00 FF Internal operating state

0-0:96.6.0 00 00 60 06 00 FF Operating time of battery

0-0:96.6.3 00 00 60 06 03 FF Battery voltage

0-0:96.7.0 00 00 60 07 00 FF Number of phase fails L1..L3

0-0:96.7.1 00 00 60 07 01 FF Number of phase fails L1

0-0:96.7.2 00 00 60 07 02 FF Number of phase fails L2

0-0:96.7.3 00 00 60 07 03 FF Number of phase fails L3

0-0:96.8.0 00 00 60 08 00 FF Total operating time

0-0:96.8.t 00 00 60 08 t FF Operating time (t = tariff number)

0-0:96.90 00 00 60 S5A FF FF Configuration ID

0-0:96.90.1 00 00 60 5A 01 FF Physical IEC device address

0-0:96.90.2 00 00 60 5A 02 FF Physical HDLC device address

1-0:96.2.7 00 00 60 02 07 FF Activation date passive TOU

0-0:97.97.0 00 00 61 61 00 FF Error code register

0-0:98.1.0*126 00 00 62 01 00 7E Stored values

0-0:240.1.0 00 00 FO 01 00 FF Device functions

0-1:96.2.5 00 01 60 02 05 FF Date and time of last calibration

0-1:96.240.8 00 01 60 FO 08 FF Hardware ID of base meter

0-1:96.3.1 00 01 60 03 01 FF Input terminal states extension board

0-1:96.3.2 00 01 60 03 02 FF Output terminal states extension board

0-2:96.240.8 00 02 60 FO 08 FF Hardware ID of extension board

0-2:96.240.9 00 02 60 FO 09 FF Reference hardware ID of extension
board

1-0:0.0.1 01 00 00 00 00 FF Identification number 1.1

1-0:0.0.2 01 00 00 00 01 FF Identification number 1.2

1-0:0.0.3 01 00 00 00 02 FF Identification number 1.3

1-0:0.0.4 01 00 00 00 03 FF Identification number 1.4

1-0:0.1.0 01 00 00 01 00 FF Reset counter
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OBIS code OBIS code (hex) Description
(decimal) ABCDETE
1-0:0.1.2 01 00 00 01 02 FF Time and date of last billing period reset
1-0:0.2.0 01 00 00 02 00 FF Software ID
1-0:0.2.1 01 00 00 02 01 FF Parameterisation ID
1-0:0.2.3 01 00 00 02 03 FF Ripple control receiver ID
1-0:0.2.4 01 00 00 02 04 FF Connection ID
1-0:0.2.7 01 00 00 02 07 FF Passive TOU ID
1-0:0.9.5 01 00 00 09 05 FF Weekday
1-0:96.99.8 01 00 60 69 08 FF Display and IEC readout ID
1-0:99.1.0 01 00 63 01 00 FF Load profile
1-0:99.98.0 01 00 63 62 00 FF Event log
1-1:0.3.0 01 01 00 03 00 FF Meter constant active energy
1-1:0.3.1 01 01 00 03 01 FF Meter constant reactive energy
1-1:0.4.0 01 01 00 04 00 FF Scale factor for demand display
1-1:04.1 01 01 00 04 01 FF Scale factor for energy display
1-1:04.2 01 01 00 04 02 FF Current transformer ratio
1-1:0.4.3 01 01 00 04 03 FF Voltage transformer ratio
1-1:13.0.0 01 01 OD 00 00 FF Average billing period power factor
1-1:13.3.n 01 01 OD 03 n FF Power factor minimum (n = number)
1-1:13.31.n 01 01 OD 23 n FF Power factor threshold (n = number)
1-1:13.35.n 01 01 OD 23 n FF Power factor monitor threshold

(n = number)
1-1:13.5.0 01 01 OD 00 00 FF Last average power factor
1-1:13.7.0 01 01 OD 07 00 FF Total power factor
1-1:14.7.0 01 01 OE 07 00 FF Mains frequency
1-1:31.7.0 01 01 1F 07 00 FF Current L1
1-1:31.35.0 01 01 1F 23 00 FF Overcurrent threshold L1
1-1:32.7.0 01 01 20 07 00 FF Voltage L1
1-1:32.31.0 01 01 20 1F 00 FF Undervoltage threshold L1
1-1:32.35.0 01 01 20 23 00 FF Overvoltage threshold L1
1-1:33.7.0 01 01 21 07 00 FF Power factor L1
1-1:51.7.0 01 01 33 07 00 FF Current L2
1-1:51.35.0 01 01 33 23 00 FF Overcurrent threshold L2
1-1:52.7.0 01 01 34 07 00 FF Voltage L2
1-1:52.31.0 01 01 34 1F 00 FF Undervoltage threshold L2
1-1:52.35.0 01 01 34 23 00 FF Overvoltage threshold L2
1-1:53.7.0 01 01 35 07 00 FF Power Factor L2
1-1:71.7.0 01 01 47 07 00 FF Current L3
1-1:71.35.0 01 01 47 23 00 FF Overcurrent threshold L3
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OBIS code OBIS code (hex) Description
imal

(decimal) ABCDETE

1-1:72.7.0 01 01 48 07 00 FF Voltage L3

1-1:72.31.0 01 01 48 1F 00 FF Undervoltage threshold L3

1-1:72.35.0 01 01 48 23 00 FF Overvoltage threshold L3

1-1:73.7.0 01 01 49 07 00 FF Power Factor L3

1-1:81.7.0 01 01 51 07 00 FF Angle U(L1) to U(L1)

1-1:81.7.1 01 01 51 07 O1 FF Angle U(L2) to U(L1)

1-1:81.7.2 01 01 51 07 02 FF Angle U(L3) to U(L1)

1-1:81.7.3 01 01 51 07 04 FF Angle I(L1) to U(L1)

1-1:81.7.4 01 01 51 07 05 FF Angle I(L2) to U(L1)

1-1:81.7.5 01 01 51 07 06 FF Angle I(L3) to U(L1)

1-1:91.7.0 01 01 5B 07 00 FF Neutral current

1-1:91.35.0 01 01 5B 23 00 FF Overcurrent threshold N

1-1:m.2.0 01 01 m 02 00 FF Cumulative maximum demand
(m = measured quantity)

1-1:m.4.0 01 01 m 04 00 FF Current average demand (m = measured
quantity)

1-1:m.6.t 0101 m 06t FF Maximum demand register
(m = measured quantity, t = tariff
number)

1-1:m.8.0 01 01 m 08 00 FF Total energy register (m = measured
guantity)

1-1:m.8.t 0101m 08t FF Energy register (cumulative)
(m = measured quantity, t = tariff
number)

1-1:m.9.t 0101 m 09t FF Energy register (billing period delta
value) (m = measured quantity, t = tariff
number)

1-1:m.29.t 0101l m 1Dt FF Energy register (registration period delta
value) (m = measured quantity, t = tariff
number)

1-1:m.35.n 01 01 m 23 n FF Demand register monitor threshold
(m = measured quantity, n = number)

1-2:82.8.0 01 02 52 08 00 FF Counter SO pulses input 1

1-3:82.8.0 01 03 52 08 00 FF Counter SO pulses input 2

a-2:m.8.0 a 02 m 08 00 FF External pulse input 1 (a = medium,
m = measured quantity)

a-3:m.8.0 a 03 m 08 00 FF External pulse input 2 (a = medium,

m = measured quantity)

Landis+Gyr
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11 List of abbreviations

Abbreviation

dims

EDIS

GSM

HDLC

IEC

.MAP

OBIS

PSTN

VDEW

Landis+Gyr

This section explains some abbreviations used in this user manual or on dialogue
windows of the Landis+Gyr .MAP120 application in alphabetical order.

Definition
Description

Distribution Line Message Specification

Messaging system defined originally as part of the application layer of the proto-
col stack for distribution line carrier systems (IEC 61334-4-41, 1996). Its universal-
ity and its independence of the actual communication channel allowed dims to
become the choice of the metering industry for any metering application (Device
Language Message Specification).

Energy Data Identification System
Identification number system for clear identification of energy data according to
DIN 43863-3:1997.

Global System for Mobile communications
Wireless communication network for data and voice transmission.

High Level Data Link Control

Communication protocol used by COSEM (IEC 62056-46), specifying the data link
layer. The HDLC standard is ISO/IEC 13239, 2000 (second edition). Some older
COSEM implementations rely on the first, 1996 edition of the standard.

International Electrotechnical Commission

IEC 62056-21 is the standard "Electricity metering - Data exchange for meter read-
ing, tariff and load control - Part 21: Direct local data exchange". This is the third
edition of the formerly well-known standard IEC 61107 (IEC 1107).

Meter Application Product

The .MAP software tools have been developed and distributed by Landis+Gyr to
support electricity meters. This group of tools comprises the .MAP 110 Parameter
Editor and the .MAP120 Parameter Editor.

Object Identification System
Identification number system for clear identification of dims items.

Public Switched Telephone Network

The public switched telephone network can be used for data transmission. To this
purpose a modem (modulator/demodulator) must be inserted between computer
and telephone network and also between the telephone network and the remote
device.

Vereinigung Deutscher Elektrizitatswerke

VDEW is the central organisation of the German electrical industry. It combines
and represents the interests of its members and is consultant and forward-looking
body for energy questions (refer also to www.strom.de).
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